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Περίληψη 
 
 
Σκοπός  

 
Είναι γνωστή η αναγκαιότητα  στον τομέα της διαχείρισης έργων της εξεύρεσης 

ενός πληροφοριακού συστήματος που να  στηρίζει με κατά το δυνατόν πιο αυτοματοποιη-
μένο και αποτελεσματικό τρόπο το σύνολο των λειτουργιών διαχείρισης, παρακολούθησης 
και ελέγχου του κύκλου ζωής ενός έργου. Τα συστήματα που αυτά που έχουν αναπτυχθεί 
είναι γνωστά ως Συστήματα Υποστήριξης της Διαχείρισης Έργων (PMIS).  

 
             Σκοπός λοιπόν αυτής της διπλωματικής εργασίας είναι η μοντελοποίηση  στο 
SAP PS ενός πρότυπου έργου, ενός εναλλάκτη αργού-νάφθας όπως αυτό έχει δοθεί στο 
MS Project. Η μελέτη περίπτωσης, ο εναλλάκτης αργού-νάφθας, που χρησιμοποιήθηκε σαν 
παράδειγμα με στόχο την επίδειξη του Project System εργαλείου του συστήματος SAP R/3, 
έχει σαν αντικείμενο το shut down του διυλιστηρίου του Ασπροπύργου των Ελληνικών 
Πετρελαίων.  
 
         Στα πλαίσια αυτής της μελέτης γίνεται μία σύντομη θεωρητική παρουσίαση του 
κύκλου ζωής ενός έργου και των σταδίων σχεδιασμού ενός έργου σε ένα πληροφοριακό 
σύστημα. Εν συνεχεία αναλύονται οι δυνατότητες δύο πακέτων εφαρμογών, του SAP 
R/3 Project System και του MS Project καθώς και τα βήματα της δημιουργίας του λόγω  
έργου στο SAP. Παρουσιάζονται στοιχεία του χρονικού προγραμματισμού αυτού του 
έργου, η προσθήκη πόρων καθώς και διαγράμματα  Gantt με την κρίσιμη διαδρομή. 
 

Τέλος, μελετώνται οι διαφορές των δύο αυτών εφαρμογών, γίνεται προσπάθεια 
σύγκρισης τους με βάση τα αποτελέσματα που δόθηκαν από τη μοντελοποίηση του έργου 
σε αμφότερα τα συστήματα, αλλά μελετώνται και παράγοντες αποτίμησης εν γένει των 
PMIS συστημάτων. 
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Kεφάλαιο 1 – ΕΙΣΑΓΩΓΗ ΣΤΗ ΔΙΑΧΕΙΡΙΣΗ ΕΡΓΩΝ 
 
 Ένα έργο είναι μια προσωρινή προσπάθεια η οποία λαμβάνει χώρα προκειμένου 
να παραχθεί – δημιουργηθεί ένα μοναδικό προϊόν ή υπηρεσία. Προσωρινή σημαίνει ότι 
κάθε έργο έχει προσδιορισμένη αρχή και τέλος. Μοναδική σημαίνει ότι το αποτέλεσμα 
κάθε έργου έχει μικρή ή μεγάλη διαφοροποίηση από τα αποτελέσματα έργων παρόμοιου 
τύπου. 
 
1.1 Ο κύκλος ζωής ενός έργου 
 
 
 Ο κύκλος ζωής ενός έργου συνίσταται από το σύνολο των φάσεων που περνά ένα 
έργο από τη στιγμή που ξεκινά μέχρι την ολοκλήρωσή του. Με τον όρο φάση έργου 
(project phase) εννοούμε το χρόνο στον οποίο ολοκληρώνονται ένα ή περισσότερα 
παραδοτέα (deliverables). Tα παραδοτέα είναι απτά και κατάλληλα επικυρωμένα 
παράγωγα εργασίας όπως μελέτη, ένα ολοκληρωμένο σχέδιο ή πρωτότυπο. 
 

 
 
Εικόνα 1.X 
Αντιπροσωπευτικός κύκλος ζωής έργου. 
 
 Οι δραστηριότητες φάσεων κύκλου ζωής ενός έργου εάν λάβουμε υπόψη το 
παραπάνω σχεδιάγραμμα συνοψίζονται στα στάδια που ακολουθούν. 
Για την αρχική φάση ενός έργου: 

• Αναγνώριση αναγκών και ερεθισμάτων του περιβάλλοντος ή πιθανών 
προβλημάτων της παρούσας κατάστασης. 

• Σύλληψη της ιδέας και των στόχων του έργου. 
• Εξέταση της ιδέας και των στόχων του έργου στα πλαίσια της στρατηγικής του 
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οργανισμού. 
• Ανάλυση της πιθανής συσχέτισης του έργου με τα εκτελεσθέντα ή τρέχοντα έργα. 
• Αρχικός προσεγγιστικός καθορισμός τεχνικής και οικονομικής σκοπιμότητας του 
έργου 

• Απόφαση για υλοποίηση έργου, επιλογή Manager & ομάδας έργου 
 

Στη φάση του  σχεδιασμού ενός έργου τα βήματα που ακολουθούνται είναι: 
• Καθορισμός των απαιτήσεων της επίδοσης του έργου. 
• Αναλυτική περιγραφή και προσδιορισμός των παραδοτέων του έργου. 
• Ανάλυση σε υποέργα, καθορισμός των interfaces μεταξύ των υποέργων, καθώς 
και των επιδράσεων του εξωτερικού περιβάλλοντος. 

• Χρονικός προσδιορισμός του έργου. 
• Προσδιορισμός των πόρων που απαιτούνται για υποστηρικτικές λειτουργίες. 
• Καθορισμός των απαιτήσεων κόστους. 
• Αρχικός προσδιορισμός των περιοχών κινδύνου για τις επόμενες φάσεις. 
• Προετοιμασία τελικών σχεδίων προγραμματισμού της υλοποίησης του έργου. 
• Καθορισμός πολιτικών, διαδικασιών, κ.λπ. για τις επόμενες φάσεις. 

 
Στη φάση της  εκτέλεσης ενός έργου έχουμε: 

• Επαλήθευση της ικανοποίησης των προκαθορισμένων απαιτήσεων 
(specifications) από το έργο. 

• Διαχείριση και συντονισμό των πόρων για την υλοποίηση του έργου. 
• Παραγωγή παραδοτέων του έργου. 
• Πραγματοποίηση δοκιμών και ελέγχων ικανοποίησης των προκαθορισμένων 
απαιτήσεων επίδοσης του έργου. 

• Ανάπτυξη τεχνικών εγχειριδίων τεκμηρίωσης του έργου. 
• Ολοκλήρωση του έργου σε υπάρχουσες ή καινούργιες οργανωτικές δομές. 
• Χρήση και λειτουργία του έργου. 

 
Τέλος, για το  κλείσιμο και την επιτυχή ολοκλήρωση ενός έργου έχουμε: 

• Αξιολόγηση της τεχνικής , οικονομικής και κοινωνικής απόδοσης του έργου σε 
συνθήκες πραγματικής λειτουργίας. 

• Παροχή πληροφοριών ανάδρασης στην ομάδα του έργου σχετικά με λάθη, 
προβλήματα, παραλείψεις, επεκτάσεις του συστήματος. 

• Ανάλυση προβλημάτων και των τρόπων με τους οποίους αντιμετωπίσθηκαν. 
• Συστάσεις για την ανάπτυξη κα τη διαχείριση μελλοντικών έργων. 
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1.2 Σχεδιασμός έργων 
 
 
 Από τις κυριότερες δραστηριότητες και παράγοντες επιτυχίας για την 
αποτελεσματική διαχείριση έργων είναι μεταξύ άλλων η μείωση της αβεβαιότητας κατά 
την υλοποίηση, η βελτίωση της αποδοτικότητας που συνδέεται με την κατανόηση των 
στόχων του έργου από τους συμμετέχοντες και η ανάγκη ύπαρξης πλαισίου για τον 
έλεγχο της προόδου των εργασιών. 
 
 Ο σχεδιασμός ενός έργου αναφέρεται στον καθορισμό  των στόχων του έργου 
και στη στρατηγική επίτευξής τους, στον προγραμματισμό των δραστηριοτήτων, στον 
προϋπολογισμό του έργου. Επίσης αναφέρεται στη  οργάνωση των θέσεων εργασίας, 
στις διαδικασίες και στις μεθόδους εκπόνησης του έργου καθώς και στα πρότυπα 
ποιότητας και στις μεθόδους εξασφάλισής της. 
 
 Ο επιτυχής σχεδιασμός ενός έργου απαιτεί ότι είναι επαρκώς προσδιορισμένα 
κατά την έναρξη του έργου τα ακόλουθα: 
Ø H έκθεση εργασιών του έργου (statement of work, SOW). 
Ø Οι συγκεκριμένες απαιτήσεις του έργου (project specifications). 
Ø Τα κρίσιμα σημεία του έργου (milestone schedule). 
Ø H ανάλυση της δομής εργασιών (work breakdown structure, WBS) 
 

 O σχεδιασμός και οι απαιτήσεις του έργου καταγράφονται σε μία Έκθεση 
εργασιών (Blueprint). Η έκθεση αναφέρεται σε συμμετέχοντες στο έργο με 
εξειδικευμένες τεχνικές γνώσεις και επεξηγεί τη χρήση συγκεκριμένου τύπου 
εξοπλισμού, υλικών και τεχνογνωσίας, αποτελώντας ταυτόχρονα σημαντικό στοιχείο για 
τη συνολική κοστολόγηση και την έγκριση των επιμέρους λεπτομερειών του έργου. 
 
 Τα κρίσιμα σημεία του σχεδιασμού του έργου άπτονται της ημερομηνίας 
έναρξης και ημερομηνίας λήξης του project, στις ημερομηνίες παράδοσης των διαφόρων 
παραδοτέων και τέλος στις ημερομηνίες ελέγχου της προόδου του έργου από τον πελάτη. 
 
 Η ανάλυση της δομής εργασιών χρησιμοποιεί έξι διαφορετικά επίπεδα: το 
πρόγραμμα (program), το έργο (project), τη δραστηριότητα (task), την υποδραστηριό-
τητα (subtask), το πακέτο εργασιών  (work package) και τις εργασίες (level of effort). 
Παράλληλα η ανάλυση δομής εργασιών αποτελεί τη βάση για τα ακόλουθα: 
Ø Τον πίνακα υπευθυνοτήτων 
Ø Το δίκτυο προγραμματισμού 
Ø Την κοστολόγηση του έργου 
Ø Την ανάλυση κινδύνων 
Ø Την οργανωτική δομή 
Ø Τον συντονισμό των στόχων του έργου  
Ø Τον έλεγχο της υλοποίησης 
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 Παρακάτω δίνεται ένα διάγραμμα συστήματος σχεδιασμού και ελέγχου έργων 
όπου απεικονίζεται η σειρά των περιγραφέντων  διαδικασιών. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Σχεδιάγραμμα 1.1 
Σύστημα σχεδιασμού και ελέγχου έργων 
 
 
 
 
 
 
 
 
 
 
 
 

Προγραμ-
ματισμός 

CPM 
 

Κύριο/ 
Αναλυτικά 
Προγράμ-
ματα 

Περιγραφή 
Εργασιών 
SOW/WBS 
Δίκτυα 

Δραστηριοτή

Στόχοι  
Έργου/Επιχ
είρησης 

Διοικητικές 
Απoφάσεις 

Εκθέσεις/Αν
αφορές 

Αξιολόγη-
ση 

 

Ανάλυση 
Κόστους 
και Πόρων 
CPM Cost 
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1.3 Σχεδιασμός έργων μέσω Πληροφοριακών Συστημάτων Υποστήριξης και Διαχείρισης 
(PMIS) 
 
 
             Η υποστήριξη με αυτοματοποιημένο τρόπο του συνόλου των λειτουργιών 
διαχείρισης, παρακολούθησης και ελέγχου του κύκλου ζωής ενός έργου καθίσταται πλέον 
απαραίτητη για τις επιχειρήσεις. Έχει μεταξύ άλλων το πλεονέκτημα της ευκολότερης 
διαχείριση μεγάλων έργων, τη δυνατότητα ταυτόχρονης διαχείρισης πολλών έργων και 
σύνδεσης μεταξύ των διαφόρων έργων, καθώς και τον αποτελεσματικό έλεγχο της εξέλιξης 
των έργων και έγκαιρη διόρθωση τυχόν αποκλίσεων από τη σχεδιασμένη πορεία.  
 
 Η δομή των Πληροφοριακών Συστημάτων Υποστήριξης της Διαχείρισης Έργων 
(Project Management Information Systems) αποτελείται από 3 κύρια υποσυστήματα: 
n Σχεδιασμού και Προγραμματισμού που αναλαμβάνει 

Ø Χρονικό προγραμματισμό έργου 
Ø Κατανομή πόρων 
Ø Κοστολόγηση του έργου και επιμέρους δραστηριοτήτων 

n Διαχείρισης 
Ø Λογιστική και οικονομική διαχείριση 
Ø Διαχείριση συντελεστών παραγωγής 

n Ελέγχου 
Ø Παρακολούθηση της προόδου των εργασιών 
Ø Έλεγχο του κόστους 
 

 Στα περισσότερα επιχειρησιακά πακέτα υποστηρίζονται και οι τέσσερις τρόποι 
σύνδεσης μεταξύ των δραστηριοτήτων (τέλος-αρχή, αρχή-αρχή, τέλος-τέλος και αρχή 
τέλος). Επίσης η διάρκεια των δραστηριοτήτων θεωρείται συνήθως σταθερή (fixed 
duration), αλλά υπάρχει και δυνατότητα επίδρασης πόρων σ’ αυτή. Έχει αναπτυχθεί ακόμη 
η δυνατότητα διαχείρισης πόρων (ανθρώπινοι πόροι, υλικά και εξοπλισμός, καθώς και η 
δυνατότητα πλήρους εξισορρόπησης των πόρων αυτών. Παρέχουν τέλος ικανοποιητικά 
αποτελέσματα σε χρονικό προγραμματισμό και παρακολούθηση πόρων και εκτίμηση 
κόστους και συγκεκριμένα trade-off μεταξύ κόστους και χρόνου. 
 
            Τα βήματα για την υλοποίηση ενός έργου με PMIS είναι τα ακόλουθα:  

• Καθορισμός ενός καθαρού στόχου για το έργο 
• Οργάνωση των δραστηριοτήτων σε μεγαλύτερες ενότητες και 
καθορισμός οροσήμων και ενδιάμεσων στόχων που σηματοδοτούν 
την ολοκλήρωση των ενοτήτων 

• Καταγραφή των δραστηριοτήτων που πρέπει να ολοκληρωθούν 
ώστε να επιτευχθεί κάθε ορόσημο και υπολογισμός της διάρκειας 
της κάθε δραστηριότητας. Δημιουργία λίστας για τις 
δραστηριότητες αυτές (Task list) και προσθήκη της αναμενόμενης 
διάρκειας για κάθε δραστηριότητα 

• Προσθήκη αλληλεξαρτήσεων ανάμεσα στις δραστηριότητες και 
περιορισμών 

• Προσθήκη πόρων (resources)  
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• Καθορισμός ημερολογίου (εργάσιμων και μη ημερών) 
• Προσθήκη κόστους για κάθε πόρο 
• Αποτύπωση της ροής των δραστηριοτήτων 
• Αφού το έργο ξεκινήσει, παρακολούθηση της προόδου, ελέγχοντας 
πραγματική απόδοση και αποτελέσματα 
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Kεφάλαιο 2 - ΓΕΝΙΚΑ ΣΤΟΙΧΕΙΑ ΓΙΑ ΤΟ SAP R/3  PROJECT SYSTEM (PS) 
ΚΑΙ ΤΟ  MS PROJECT  (MICROSOFT PROJECT SYSTEM) 
  
 
2.1 Εισαγωγικά στοιχεία για το SAP R/3 
 
 
 Τα Ολοκληρωμένα Συστήματα Διαχείρισης Επιχειρησιακών Πόρων (Enterprise 
Resource Planning Systems - ERP) είναι ένα συμπαγές σύνολο εφαρμογών λογισμικού 
που υποστηρίζουν ευρύ φάσμα επιχειρησιακών δραστηριοτήτων και λειτουργιών κι ένα 
επιχειρησιακό εργαλείο ελέγχου, παρακολούθησης και συντονισμού των εργασιών στις 
κεντρικές και απομακρυσμένες εγκαταστάσεις μιας επιχείρησης. Επιτυγχάνουν τη 
συγκέντρωση των δεδομένων, την ενοποίηση και ολοκλήρωση όλων των εφαρμογών μίας 
επιχείρησης και τον επανασχεδιασμό των επιχειρησιακών διαδικασιών, επιδιώκοντας τη 
βελτιστοποίηση των λειτουργιών, την αύξηση της παραγωγικότητας, και την απόκτηση 
συγκριτικού πλεονεκτήματος μέσα από τη χρησιμοποίηση νέων τεχνολογιών 
πληροφορικής. Για τις σύγχρονες επιχειρήσεις στην Κοινωνία της Πληροφορίας, τα ERP 
αποτελούν το βασικό πυλώνα της transactional πληροφοριακής υποδομής που επιτρέπει σε 
εταιρίες και οργανισμούς να ανταποκριθούν στις απαιτήσεις και προκλήσεις της 
οικονομικής δραστηριότητας στα πλαίσια της παγκοσμιοποίησης. 
  
 Το SAP R/3 είναι ένα τέτοιο πακέτο επιχειρησιακού λογισμικού, το οποίο 
λειτουργεί επί ενός συστήματος (hardware) που ονομάζεται σύστημα πελάτη - εξυπηρετητή 
(Client - Server). Το σύστημα αυτό επιτρέπει τη διασύνδεση πολλών υπολογιστικών 
τμημάτων καθένα από τα οποία αναλαμβάνει συγκεκριμένα τμήματα υπολογιστικής 
διαχείρισης σε πολλά επίπεδα με σκοπό τη βέλτιστη συνολική απόδοση του συστήματος. 
 
 Το σύστημα του πελάτη - εξυπηρετητή του SAP R/3 περιλαμβάνει τα παρακάτω 3 
βασικά επίπεδα: 

• Επίπεδο κεντρικού υπολογιστή που εξυπηρετεί τη διαχείριση των 
λειτουργιών της Βάσης Δεδομένων (Central Computer - Data Base 
Server)  

• Επίπεδο υπολογιστή εφαρμογών που εξυπηρετεί τη βασική διαχείριση 
των προγραμμάτων των εφαρμογών (Application server)  

• Επίπεδο σταθμών εργασίας που εξυπηρετεί τη βασική διαχείριση της 
καταχώρησης και της εμφάνισης των δεδομένων στις οθόνες που 
χειρίζονται οι χρήστες (Presentation Server) 

 
 Με το σύστημα αυτό ο χρήστης έρχεται σε επαφή μόνο με το τελευταίο επίπεδο 
στους σταθμούς εργασίας (Presentation Server) και από το επίπεδο αυτό χειρίζεται το 
σύστημα. Στο επίπεδο αυτό το περιβάλλον εργασίας είναι αυτό των Windows που 
επιτρέπουν στο χρήστη σε συνδυασμό με τα προγράμματα το άνοιγμα μέχρι 9 
διαφορετικών παραθύρων εργασίας (sessions) του SAP R/3, το παράλληλο άνοιγμα 
παραθύρων άλλων εφαρμογών από τα windows πχ επεξεργαστών κειμένων κ.λπ. ,τη 
διαχείριση των παραμέτρων των εκτυπωτών, των δικτύων, των συνόλων χαρακτήρων 
(character sets) κλπ. 
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 Το  SAP R/3 διαθέτει χαρακτηριστικά που του επιτρέπουν να λειτουργεί ένα 
ολοκληρωμένο λογιστικό περιβάλλον, στο οποίο τηρούνται όλες οι επιχειρησιακές 
κινήσεις. Το γράμμα R στην ονομασία R/3 του συστήματος οφείλεται στον τεχνικό όρο της 
Αγγλικής real time (πραγματικός χρόνος) που αποτελεί ένα από τα σημαντικότερα 
χαρακτηριστικά του συστήματος. Το χαρακτηριστικό αυτό προσδίδει τη βασική ιδιότητα 
στο σύστημα της άμεσης σε πραγματικό χρόνο ενημέρωσης όλων των αρχείων μετά την 
ολοκλήρωση της καταχώρισης κάθε κίνησης. Το σύστημα ελέγχει άμεσα τα 
καταχαρούμενα στις οθόνες δεδομένα και ενημερώνει το χρήστη για τα αποτελέσματα του 
ελέγχου καθώς και για τις επεξεργασίες που γίνονται στη συνέχεια αυτόματα. 
 
 Η ιδιότητα αυτή επιτρέπει την άμεση ενημέρωση και διάθεση των πληροφοριών του 
συστήματος, αλλά επιβάλλει παράλληλα και το μοναδικό τρόπο διόρθωσης των 
εσφαλμένων εγγραφών που για κάθε περίπτωση είναι ο αντιλογισμός. 
 
 Το σύστημα λογισμικού SAP R/3 είναι ένα πακέτο λογισμικού που μπορεί να 
διαχειρίζεται δεδομένα που αφορούν πολλές χώρες, γλώσσες και εταιρίες και αποτελείται 
από πολλά υποσυστήματα (FI, MM, SD, CO, PM, PS το οποίο θα εξετάσουμε εκτενέστερα 
στη συνέχεια). 
 

 Τα υποσυστήματα του SAP ERP διαχειρίζονται κοινά δεδομένα που είναι 
αποθηκευμένα σε αρχεία, τα οποία χωρίζονται σε 3 κατηγορίες: 

• Δεδομένα βασικών αρχείων 
• Δεδομένα αρχείων κινήσεων 
• Δεδομένα παραμέτρων 
 

 Τα δεδομένα των βασικών αρχείων περιλαμβάνουν στατικές και δυναμικές 
πληροφορίες. Οι στατικές πληροφορίες παραμένουν για σχετικά μεγάλα διαστήματα 
αναλλοίωτες (π.χ. τα σταθερά στοιχεία των πελατών π.x. η Διεύθυνση και το όνομα). Οι 
δυναμικές πληροφορίες ενημερώνονται αυτόματα από το σύστημα σε πραγματικό χρόνο 
μετά την ολοκλήρωση της καταχώρισης κάθε κίνησης. Το κύριο χαρακτηριστικό των 
αρχείων αυτών είναι οι κωδικοί (όπως οι κωδικοί των λογαριασμών της Γενικής 
Λογιστικής, των Πελατών κ.λπ.) 
 
 Τα δεδομένα των αρχείων κινήσεων περιλαμβάνουν ιστορικές πληροφορίες που 
αφορούν τις επιχειρησιακές κινήσεις. Το κύριο χαρακτηριστικό των αρχείων αυτών είναι οι 
ημερομηνίες στις οποίες καταχωρήθηκαν οι επιχειρησιακές κινήσεις. Οι πληροφορίες των 
κινήσεων χωρίζονται στις πληροφορίες τίτλου (header) και στις πληροφορίες αναλυτικής 
γραμμής (line). Οι πληροφορίες τίτλου περιλαμβάνουν μεταξύ άλλων τις πληροφορίες που 
αφορούν ένα παραστατικό (όπως στο τιμολόγιο πελάτη την ημερομηνία, τον αριθμό του 
τιμολογίου τον κωδικό του πελάτη κ.λπ.).Οι πληροφορίες αναλυτικής γραμμής 
περιλαμβάνουν μεταξύ άλλων τις πληροφορίες που αφορούν την ανάλυση του 
παραστατικού (π.χ. στο τιμολόγιο πελάτη την ανάλυση των ειδών, τις τιμές , τις επιμέρους 
αξίες κλπ) 
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 Τα δεδομένα των αρχείων παραμέτρων περιλαμβάνουν πληροφορίες που 
αφορούν τους κανόνες λειτουργίας του συστήματος όπως για παράδειγμα τον κωδικό 
κίνησης που καθορίζει ότι η αξία που καταχωρείται αφορά χρέωση κ.λπ. 
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2.2 Εισαγωγικά στοιχεία για το Υποσύστημα Παρακολούθησης Έργων μέσω του SAP 
R/3 (Project System PS) 
 
 

Το υποσύστημα Παρακολούθησης Έργων (Project System) είναι ένα από τα 
βασικά οικονομικά υποσυστήματα, αν και το σύστημα SAP ERP το εντάσσει ταυτόχρονα 
και στα οικονομικά υποσυστήματα και στα υποσυστήματα της Εφοδιαστικής. Το 
υποσύστημα Παρακολούθησης Έργων αφορά κυρίως επιχειρήσεις που εκτελούν μεγάλα 
και σύνθετα έργα, και έχει σκοπό τον προγραμματισμό, τον έλεγχο, την κοστολόγηση και 
την παρακολούθηση της εκτέλεσης των εργασιών που σχετίζονται με αυτά. 

 
Θεωρήσαμε σκόπιμο να εντάξουμε το υποσύστημα αυτό στην Ομάδα των 

Οικονομικών Εφαρμογών και όχι στην ομάδα της Εφοδιαστικής καθώς η δημιουργία 
πρότυπου μοντέλου που είναι και στόχος της εργασίας δεν αφορά την παρακολούθηση 
των υλικών και των διαδικασιών που αφορούν την Εφοδιαστική αλλά την 
παρακολούθηση των εργασιών, του κόστους και των σχετικών πληροφοριών που 
αφορούν τα οικονομικά. 

 
Η πιο σημαντική έννοια του υποσυστήματος της Παρακολούθησης Έργων είναι η 

έννοια του έργου. 
 
Το έργο (project) ενός συνόλου εργασιών που περιλαμβάνουν την επίτευξη ενός 

προκαθορισμένου στόχου (predetermined goal), με καθορισμένα κεφάλαια (prescribed 
funds)  και λειτουργικούς πόρους (operating resources), σε ένα συμφωνημένο επίπεδο 
ποιότητας (agreed level of quality), μέχρι και μία συγκεκριμένη ημερομηνία (by a 
particular date). 

 
Τα έργα είναι προγραμματισμένες εργασίες που έχουν τα παρακάτω ειδικά 

χαρακτηριστικά: 
• Είναι συνήθως σύνθετα, μοναδικά και εμπεριέχουν κινδύνους. 
• Έχουν ξεκάθαρους και συμφωνημένους στόχους μεταξύ αυτού που τα 
παραγγέλνει και του ανάδοχου (εργολάβου) που αναλαμβάνει να τα 
υλοποιήσει. 

• Έχουν προκαθορισμένη διάρκεια και συνήθως εμπλέκουν πολλά τμήματα 
της επιχείρησης και είναι στρατηγικής σημασίας για την επιχείρηση. 

• Διαρκούν αρκετά και ενδεχομένως αφορούν περισσότερες από μία 
οικονομικές χρήσεις. 

 
 Τα βασικά στάδια ενός έργου είναι τα ακόλουθα: 

Ø Προδιαγραφή του έργου (Project specification) 
Ø Αξιολόγηση (Validation) 
Ø Σχεδιασμός προγράμματος (Project plan) 
Ø Επαλήθευση προγράμματος (Plan execution) 
Ø Έλεγχος εκτέλεσης (Plan control) 

Στο σύστημα SAP ERP το έργο είναι μια δομή που ονομάζεται δομή του έργου 
(project structure), η οποία περιλαμβάνει τις παρακάτω οντότητες: 
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• Tον ορισμό του έργου (project definition), που περιέχει πληροφορίες και 
δεδομένα που αφορούν το σύνολο του έργου, όπως για παράδειγμα, τις 
ημερομηνίες έναρξης και λήξης του έργου, τα οργανωτικά δεδομένα κ.λπ. Ο 
ορισμός του έργου καθορίζει το πλαίσιο (Framework) για την ανάληψη 
εργασιών, που έχουν καθορισμένο σκοπό (fixed goal) και δεδομένους πόρους 
(given resources), και περιλαμβάνει οργανωτικές πληροφορίες (organizational 
information), παραμέτρους προγραμματισμού και βασικές ημερομηνίες που 
αφορούν όλη τη δομή ανάλυσης εργασιών του έργου. 

• Τη δομή ανάλυσης εργασιών (Work breakdown structure), που είναι μια 
ιεραρχική δομή πολλών επιπέδων η οποία περιλαμβάνει τα μέρη και τις 
δραστηριότητες του έργου που πρέπει να εκτελεστούν ιεραρχική μορφή 
(hierarchical organization) της δομής ανάλυσης τν εργασιών αποτελείται από τα 
στοιχεία της δομής ανάλυσης εργασιών (work breakdown structure 
elements). 
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Εικόνα 2.1 
Η πρόσβαση στις επιλογές του υποσυστήματος Παρακολούθησης Έργων (Project System) 

 
 
Η δομή και η ανάλυση των έργων σε μέρη έχουν δύο όψεις: 
 

• Τη δομή που αναλύει το έργο σε μέρη, (όπως συνήθως τα αντιλαμβάνεται ο 
παραγγέλων το έργο) τα οποία αντιστοιχούν στα στοιχεία της δομής 
ανάλυσης εργασιών (work breakdown structure elements) 

• Τη δομή που αναλύει το έργο σε μέρη (όπως συνήθως το αντιλαμβάνεται ο 
κατασκευαστής), τα οποία αντιστοιχούν στις δραστηριότητες των έργων 
(activities), περιγράφουν τα βήματα και τις διάφορες εργασίες που 
περιλαμβάνονται σε ένα έργο, καθώς επίσης και τις σχέσεις που έχουν 
μεταξύ τους. 

 
Το υποσύστημα  της Παρακολούθησης Έργων χρησιμοποιείται στη χώρα μας από 

αρκετές εταιρίες, οι οποίες είναι εξοικειωμένες με τις έννοιες που αναφέρθηκαν 
παραπάνω, καθώς είναι είτε τεχνικές εταιρίες είτε είναι επιχειρήσεις που εκτελούν συχνά 
μεγάλα επενδυτικά έργα όπως είναι και η εταιρία στη μελέτη περίπτωσης έργου που θα 
αναλύσουμε εκτενώς στη συνέχεια. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



ΔΙΠΛΩΜΑΤΙΚΗ ΕΡΓΑΣΙΑ - ΜΟΝΤΕΛΟΠΟΙΗΣΗ ΕΡΓΟΥ ΜΕΣΩ SAP PROJECT SYSTEM  

ΜΕΤΑΠΤΥΧΙΑΚΟ ΠΡΟΓΡΑΜΜΑ ΣΠΟΥΔΩΝ ΣΤΗΝ ΟΙΚΟΝΟΜΙΚΗ ΚΑΙ ΕΠΙΧΕΙΡΗΣΙΑΚΗ 
ΣΤΡΑΤΗΓΙΚΗ 

18  
 
Economic & Business Strategy 

2.3 Διαχείριση Έργων στο SAP 
 
 

Η εφαρμογή της Διαχείρισης Έργων είναι μία βασική οικονομική εφαρμογή  και 
η κύρια εργασία της είναι ο προγραμματισμός, η κοστολόγηση και η παρακολούθηση 
των έργων που περιλαμβάνει διαδικασίες που σχετίζονται με την παρακολούθηση των 
ημερομηνιών έναρξης και λήξης των εργασιών, τον προϋπολογισμό του έργου, τις 
απαιτήσεις των υλικών, εξωτερικών συνεργατών και κέντρων εργασίας. 

 
Οι βασικές διαδικασίες της εφαρμογής της Διαχείρισης Έργων είναι: 
• Η διαχείριση των βασικών δεδομένων (Master data), που περιλαμβάνει τη 
συντήρηση των δεδομένων των έργων 

• Οι καθημερινές εργασίες της παρακολούθησης των έργων, που περιλαμβάνουν 
αφενός τον προγραμματισμό και τον προϋπολογισμό των έργων και αφετέρου τις 
καταχωρίσεις εξόδων και εσόδων, καθώς και όλων των κινήσεων με τις οποίες 
αυτές ενημερώνονται. 

• Η εκτύπωση των καταστάσεων και των αναφορών που σχετίζονται με τα έργα, 
όπως, για παράδειγμα, οι καταστάσεις κόστους έργων, οι καταστάσεις προόδου, ο 
προϋπολογισμός των έργων κ.λπ. 

 
Τα σημαντικότερα βασικά αρχεία (Master data) της εφαρμογής της Διαχείρισης 

Έργων είναι: 
Ø Το αρχείο των ορισμών των έργων 
Ø Η δομή της ανάλυσης εργασιών των έργων 
Ø Οι δραστηριότητες των έργων 
Ø Τα δίκτυα εργασιών 
 
Ένα έργο για να καταχωρηθεί στο σύστημα SAP ERP, απαιτείται να καταχωρηθεί ως 
δομή έργου (project structure) η οποία περιλαμβάνει: 

§ Τον ορισμό του έργου (project definition), ο οποίος καταχωρείται αρχικά 
σε ειδικές οθόνες τίτλου που απαιτούν δεδομένα τα οποία αφορούν το 
σύνολο του έργου, όπως, για παράδειγμα τις ημερομηνίες έναρξης λήξης 
του έργου, τα οργανωτικά δεδομένα κ.λπ. 

§ Τη δομή ανάλυσης εργασιών (Work breakdown structure), η οποία 
καταχωρείται στη συνέχεια σε ειδικές οθόνες γραμμών που 
περιλαμβάνουν τα μέρη και τις δραστηριότητες του έργου οι οποίες 
πρέπει να εκτελεστούν σε ιεραρχική μορφή αποτελούμενη από στοιχεία 
(elements)  

 
O ορισμός του έργου (project definition) νους καθορίζει το πλαίσιο για την 

ανάληψη εργασιών που έχουν τον ίδιο σκοπό και δεδομένους πόρους και περιλαμβάνει 
οργανωτικές πληροφορίες, παραμέτρους προγραμματισμού και βασικές ημερομηνίες οι 
οποίες αφορούν όλη τη δομή ανάλυσης εργασιών του έργου. Το πιο πεδίο ορισμού του 
έργου είναι ο τύπος έργου (project type). 
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 Ο τύπος έργου (Project type) είναι ένας κωδικός που χρησιμοποιείται για την 
ομαδοποίηση έργων με παρόμοια χαρακτηριστικά. 
 Οι πιο συνηθισμένες ομάδες έργων που αντιστοιχούν σε διαφορετικούς τύπους 
έργων και χρησιμοποιούνται στην Ελλάδα είναι: 

• Τα επενδυτικά έργα (Capital investment projects) 
• Τα έργα πελατών (Customer projects) 
• Τα αναπτυξιακά έργα (Development projects) 
 

 Η δομή ανάλυσης εργασιών αποτελείται από τα στοιχεία της δομής ανάλυσης 
εργασιών (work breakdown structure elements), τα οποία είναι οργανωμένα σε 
ιεραρχική μορφή  (hierarchical organization) και αποτελούν τα πραγματικά κοστολογικά 
αντικείμενα που  επιδέχονται κόστη, έσοδα και έξοδα. 
 

  
Εικόνα 2.2 
Η οθόνη καταχώρισης των στοιχείων της δομής ανάλυσης εργασιών (Work breakdown 
structure elements). 
 
 Τα στοιχεία της δομής ανάλυσης εργασιών (work breakdown structure elements) 
είναι τα αντικείμενα που χρησιμοποιούνται στον προγραμματισμό και στην καταχώριση 
των πραγματικών δεδομένων τα οποία εντάσσονται στα πακέτα εργασίας (work 
packages) του έργου. 
 
 Τα στοιχεία της δομής ανάλυσης εργασιών χαρακτηρίζονται από λειτουργικούς 
δείκτες (operative indicators) που τους επιτρέπουν: 

• Να μπορούν προγραμματιστούν (planning elements) 
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• Να δέχονται πραγματικά κόστη (account assignment elements) 
• Να δέχονται πραγματικά έσοδα και να είναι τιμολογήσιμα (billing elements). 

 Οργανωτικά, τα στοιχεία της δομής ανάλυσης εργασιών μπορούν να συνδεθούν 
με: 

• Κέντρα κέρδους, ώστε να παρακολουθούνται τα οικονομικά τους αποτελέσματα 
• Επιχειρησιακές περιοχές  
• Υπεύθυνους και συνεργάτες  
• Κέντρα κόστους, στα οποία μπορούν να τακτοποιηθούν (settled).Τα κέντρα 
κόστους είναι βασικά αρχεία αλλά και οργανωτικές μονάδες. Αντιπροσωπεύουν 
τις περιοχές ευθύνης στις οποίες διακινούνται και συλλέγονται κόστη (area of 
responsibility for capturing costs). 

 Επιπρόσθετα, τα στοιχεία της δομής ανάλυσης εργασιών μπορούν να συνδεθούν 
με: 

• Ημερομηνίες ορόσημα (Milestones), που χρησιμοποιούνται τόσο στον 
προγραμματισμό των εργασιών όσο και για την παρακολούθηση της προόδου των 
έργων. 

• Προγράμματα τιμολόγησης (Billing plans), τα οποία έχουν σκοπό τον 
προγραμματισμό των εσόδων. 

• Έγγραφα (documents) και κείμενα που αναφέρονται στις προδιαγραφές του 
στοιχείου της δομής ανάλυσης των εργασιών. 

• Ομάδες εργασίας (Project teams), στις οποίες θα κατανεμηθούν οι εργασίες. 
• Αναλυτικές γραμμές προγράμματος επενδύσεων (Investment program items), 
που χρησιμοποιούνται για την κατανομή του προϋπολογισμού σε ανώτερο 
επίπεδο από αυτό του έργου. 

 
 Οι δραστηριότητες των έργων (activities) περιγράφουν τα βήματα και τρις 
διάφορες εργασίες που περιλαμβάνονται σε ένα έργο, καθώς επίσης και τις σχέσεις που 
έχουν μεταξύ τους. 
 
 Οι δραστηριότητες εστιάζονται κυρίως στον προγραμματισμό, τον έλεγχο του 
κόστους των εργασιών, τις ημερομηνίες, τους πόρους και τις αναλώσεις υλικών. 
 
 Αρχικά δημιουργούνται στα στοιχεία της δομής ανάλυσης εργασιών και στη 
συνέχεια συνδέονται μεταξύ τους και δημιουργούν τις ακολουθίες δραστηριοτήτων 
(activity sequences) και συγκροτούν δίκτυα (networks). 
 
 To δίκτυο εργασιών ενός έργου (project network) είναι ένα σύνολο οδηγιών 
που αφορούν το πώς θα εκτελεστούν οι εργασίες του έργου, με ποια σειρά σε κάποιο 
συγκεκριμένο χρονικό διάστημα. Τα βασικά δομικά στοιχεία ενός δικτύου είναι οι 
δραστηριότητες και οι σχέσεις τους.  
 
 Τα ορόσημα (Milestones) είναι γεγονότα που έχουν ιδιαίτερη σημασία στη ροή 
των εργασιών ενός έργου. Ορόσημα μπορούν να καθοριστούν τόσο στις δραστηριότητες 
όσο και στα στοιχεία της δομής ανάλυσης εργασιών και να χρησιμοποιηθούν ως 
ημερομηνίες έναρξης διαδικασιών, όπως για παράδειγμα για να αρχίσει η έκδοση 
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τιμολογίων ή για να σηματοδοτηθούν εργασίες της ροής εργασίας (workflow tasks) και 
να μετρηθεί η πρόοδος του έργου. 
 
            Οι τύποι δραστηριοτήτων (Activity Types) κατηγοριοποιούν τις 
δραστηριότητες που παρέχονται από τα κέντρα κόστους, έτσι ώστε να χρησιμοποιηθούν 
για την κατανομή του κόστους στα αντικείμενα κόστους που παρέλαβαν τη 
δραστηριότητα με κριτήριο την ποσότητα των εσωτερικών δραστηριοτήτων (internal 
activities) που παρέλαβαν. 
 
 Ο πινάκας προγραμματισμού του έργου (project planning board) είναι ένα 
εργαλείο που βασίζεται στο διάγραμμα Gantt (Gantt chart) και με αυτό μπορούν να 
διευκολυνθούν η δημιουργία, η εποπτεία και η επεξεργασία των δεδομένων 
προγραμματισμού των έργων.  
 
 Το διάγραμμα Gantt είναι ένα χρονικό διάγραμμα που επιτρέπει τη συνολική 
εποπτεία των εργασιών ενός έργου και την εμφάνιση των ημερομηνιών έναρξης και 
λήξης καθώς και τις συνδέσεις των εργασιών μεταξύ τους. Το διάγραμμα είναι ένα 
γραφικό διάγραμμα που απεικονίζει πληροφορίες προγραμματισμού έργων (schedule 
related information) οι οποίες περιλαμβάνουν στον κατακόρυφο άξονα τις 
δραστηριότητες (activities) και σε οριζόντιο άξονα τις ημερομηνίες και τις διάρκειες 
(durations) των δραστηριοτήτων. 
 
 Οι ημερομηνίες που σχετίζονται με τα έργα και τις δραστηριότητες τους  
καταχωρούνται από τους χρήστες ή προκύπτουν αυτόματα με κατάλληλους 
υπολογισμούς αναφερόμενες σε πολλά επίπεδα όπως: 

• Σε επίπεδο ορισμού  του έργου  
• Σε επίπεδο δικτύου, σε επίπεδο δραστηριότητας 
• Σε επίπεδο στοιχείων δομής ανάλυσης εργασιών 

 Οι ημερομηνίες που σχετίζονται με τα έργα και τις δραστηριότητές τους 
ομαδοποιούνται στις παρακάτω κατηγορίες 

• Βασικές ημερομηνίες (Basic Dates) που καθορίζονται από τους χρήστες σε 
επίπεδο ορισμού του έργου, δικτύου, δραστηριότητος και στοιχείων δομής 
ανάλυσης εργασιών. 

• Ημερομηνίες προβλέψεων (Forecast Dates) που καθορίζονται από τους χρήστες 
και επιτρέπουν τον λεπτομερή προγραμματισμό ενός σεναρίου για 
πληροφοριακούς λόγους. 

• Λεπτομερώς προγραμματισμένες ημερομηνίες (Scheduled Dates), που 
υπολογίζονται αυτόματα από τον προγραμματισμό των δραστηριοτήτων και 
εμφανίζονται και σε επίπεδο στοιχείων δομής ανάλυσης εργασιών, όπως 
κληρονομούνται από τις δραστηριότητες με τις οποίες τα στοιχεία αυτά είναι 
συνδεδεμένα. 

• Πραγματικές ημερομηνίες (Actual Dates), οι οποίες είναι οι πραγματικές 
ημερομηνίες έναρξης και λήξης των εργασιών, όπως έχουν καταχωρηθεί σε όλα 
τα επίπεδα από τους χρήστες. 
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 Στα έργα που δε συνοδεύονται από δίκτυα, οι παραπάνω ημερομηνίες δηλώνονται 
στα στοιχεία της δομής ανάλυσης των εργασιών ως βασικές ημερομηνίες, ενώ σε αυτά 
που συνοδεύονται από δίκτυα χρησιμοποιείται πάντα ο λεπτομερής προγραμματισμός 
των ημερομηνιών των δραστηριοτήτων, από τις οποίες προκύπτουν αυτόματα και οι 
ημερομηνίες των στοιχείων της δομής ανάλυσης εργασιών που είναι συνδεδεμένα με 
αυτές. 
 
 Τα δίκτυα των έργων προγραμματίζονται με δύο μεθόδους που διαθέτει το 
σύστημα SAP ERP, οι οποίες χρησιμοποιούνται ανάλογα με τον τρόπο 
προγραμματισμού που χρησιμοποιεί η κάθε εταιρία και είναι οι εξής: 
Ø Προγραμματισμός προς τα εμπρός (forward scheduling) 
Ø Προγραμματισμός προς τα πίσω (backward scheduling) 
 

 Ο υπολογισμός των νωρίτερων ημερομηνιών (earliest dates) γίνεται με 
προγραμματισμό προς τα εμπρός (forward),ενώ ο υπολογισμός των αργότερων 
ημερομηνιών γίνεται με προγραμματισμό προς τα πίσω (backward). 
 
 Οι διαφορές μεταξύ νωρίτερων και αργότερων ημερομηνιών που προκύπτουν σε 
μία δραστηριότητα ονομάζονται ταλάντωση (float). Η ταλάντωση είναι  ο αδιάφορος 
χρόνος (slack time)  για τη εκτέλεση μίας δραστηριότητας, ο οποίος στην ουσία αποτελεί 
και το μέγιστο διαθέσιμο χρόνο για μετακίνηση ημερομηνιών μιας δραστηριότητας χωρίς 
να επηρεαστεί το έργο. 
 
 Οι δραστηριότητες αναλύονται σε στοιχεία δραστηριοτήτων (activity 
elements), που μπορεί να εκτελεστούν είτε εσωτερικά από τα κέντρα εργασίας της 
εταιρίας ή εξωτερικά, δηλαδή από εξωτερικά συνεργεία, τα οποία ανήκουν σε 
προμηθευτές της και θα τιμολογήσουν την εταιρία για τις εργασίες τους. 
 
  Οι δραστηριότητες δέχονται αναλώσεις υλικών (material consumptions), που 
προγραμματίζονται συνδέοντας τις δραστηριότητες με συστατικά (components).Αυτά 
μπορεί να είναι αποθηκευμένα υλικά(stock materials) είτε όχι (non stock materials) και 
να απαιτείται να αγοραστούν για άμεση ανάλωση στη συγκεκριμένη δραστηριότητα του 
έργου η οποία κοστολογείται ανάλογα. 
 
 Ένας απλός τρόπος σύνδεσης των υλικών με δραστηριότητες είναι η χρήση 
πινάκων τεχνικών προδιαγραφών ειδικών για τα έργα (Bill of Materials for projects 
BOM-PS).Για παράδειγμα, σε ένα τεχνικό έργο που απαιτεί οπλισμένο σκυρόδεμα, 
μπορεί να καθοριστεί ο πινάκας τεχνικών προδιαγραφών ειδικών για τα έργα που αφορά 
το σκυρόδεμα, ώστε να γίνουν αυτόματες αναλώσεις υλικών, π.χ. τσιμέντου και χάλυβα, 
σύμφωνα με τις προδιαγραφές του πινάκα. 
 
 Ο προγραμματισμός του κόστους του έργου βασίζεται στον προγραμματισμό με 
στοιχεία κόστους (cost element based planning).Υπάρχουν δύο τρόποι να 
προγραμματιστεί το κόστος των έργων: 
Ø προγραμματισμός των στοιχείων της δομής ανάλυσης των εργασιών 



ΔΙΠΛΩΜΑΤΙΚΗ ΕΡΓΑΣΙΑ - ΜΟΝΤΕΛΟΠΟΙΗΣΗ ΕΡΓΟΥ ΜΕΣΩ SAP PROJECT SYSTEM  

ΜΕΤΑΠΤΥΧΙΑΚΟ ΠΡΟΓΡΑΜΜΑ ΣΠΟΥΔΩΝ ΣΤΗΝ ΟΙΚΟΝΟΜΙΚΗ ΚΑΙ ΕΠΙΧΕΙΡΗΣΙΑΚΗ 
ΣΤΡΑΤΗΓΙΚΗ 

23  
 
Economic & Business Strategy 

Ø Ο προγραμματισμός των δραστηριοτήτων που ονομάζεται και κοστολόγηση 
δικτύου 

 
 Ο πρώτος τρόπος έχει το πλεονέκτημα ότι αναλύει και κοστολογεί το έργο σε 

μέρη όπως συνήθως τα αντιλαμβάνεται ο πελάτης που ενδεχομένως θα αγοράσει το έργο, 
ενώ ο δεύτερος τρόπος ότι αναλύει και κοστολογεί το έργο όπως συνήθως τα 
αντιλαμβάνεται ο κατασκευαστής. 

 
 Ο δεύτερος τρόπος παρουσιάζει επίσης το πλεονέκτημα αφενός ότι μπορεί να 

αντιγραφεί σε πολλά παρόμοια έργα και αφετέρου ότι έχει τη δυνατότητα να 
ενημερώνεται όταν οι εργασίες μετατοπίζονται χρονικά λόγω αναθεωρήσεων του 
προγραμματισμού. 

 
 Όταν προγραμματίζονται οι πόροι και οι ημερομηνίες στις δραστηριότητες ενός 
δικτύου τα προγραμματισμένα κόστη υπολογίζονται αυτόματα από: 
Ø Τις δραστηριότητες που αφορούν εσωτερικές εργασίες 
Ø Τα πρωτογενή κόστη που αφορούν εξωτερικές εργασίες 
Ø Τα πρωτογενή κόστη που αφορούν υλικά 
 

 Τα έσοδα προγραμματίζονται στο έργο έπειτα από σύνδεσή τους με εγγραφές 
πωλήσεων (SD documents), οι οποίοι αναφέρονται σε συγκεκριμένα στοιχεία της δομής 
ανάλυσης εργασιών που έχουν χαρακτηριστεί με τους κατάλληλους δείκτες ότι 
επιδέχονται έσοδα. 
 
 Μετά τον προγραμματισμό του κόστους του έργου (cost planning) μπορεί να γίνει 
ο προϋπολογισμός (budgeting), ο οποίος διαφέρει από τον προγραμματισμό στο ότι είναι 
δεσμευτικός, καθώς αφορά κεφάλαια (funds). 
 
 Αμέσως μετά την έγκριση του έργου (release of the project) μπορεί να αρχίσει η 
καταχώριση των πραγματικών δεδομένων που είναι δυνατόν να προέρχεται από πολλά 
υποσυστήματα όπως: 
 
 Από το υποσύστημα Οικονομικής Διαχείρισης (FI), που αφορά κυρίως 
εγγραφές τιμολογίων προμηθευτών εξόδων που σχετίζονται με συγκεκριμένα στοιχεία 
ανάλυσης εργασιών του έργου, όπως έχουν δηλωθεί κατά την καταχώρησή τους, ή 
παγιοποιήσεις συνόλων ή μερών έργων (Settlement to assets) που καταχωρούνται 
περιοδικά. 
 
 Από το υποσύστημα Διαχείρισης Υλικών (MM), που αφορούν αγορές υλικών 
και υπηρεσιών με εντολές αγορών ,παραλαβές υλικών από την αποθήκη (Goods receipts) 
και χορηγήσεις (Goods issues) στα στοιχεία δομής ανάλυσης των έργων. 
 
 Από το υποσύστημα Πωλήσεων και Διανομής (SD), που αφορούν τιμολογήσεις 
μερών του έργου για συγκεκριμένα στοιχεία της δομής ανάλυσης εργασιών που έχουν 
χαρακτηριστεί με τους κατάλληλους δείκτες ότι επιδέχονται έσοδα. 
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 Από το υποσύστημα Προγραμματισμού Παραγωγής (PP), που αφορά 
επιβεβαιώσεις εντολών παραγωγής που έχουν συνδεθεί με το έργο 
. 
 Από το υποσύστημα Συντήρησης Εγκαταστάσεων (PM), που αφορούν 
επιβεβαιώσεις εντολών συντήρησης που έχουν συνδεθεί με το έργο. 
 
 Κατά την εκτέλεση των εργασιών ενός έργου ζητούνται συχνά πληροφορίες 
εναλλακτικών σεναρίων που βασίζονται στην ερώτηση «τι θα γινόταν αν» (what if 
planning scenarios).Oι πληροφορίες των σεναρίων αυτών μπορούν να προκύψουν από 
εκδόσεις προσομοίωσης (Simulation versions), οι οποίες δημιουργούνται ως κατάλληλα 
αντίγραφα των δεδομένων του λειτουργικού έργου που περιέχει τα πραγματικά δεδομένα 
και επιτρέπουν την καταχώριση των σεναρίων για την εξαγωγή συμπερασμάτων σε 
σχέση με το μελλοντικό κόστος ή τις μελλοντικές ημερομηνίες. 
 
 Οι τεχνικές μέτρησης της προόδου των έργων (Measurement technique) είναι 
διαδικασίες που χρησιμοποιούνται για να υπολογίσουν το ποσοστό ολοκλήρωσης 
(Percentage of completion) ενός έργου για την ανάλυση προόδου (Progress analysis). 
 
 Οι σημαντικότερες τεχνικές μέτρησης που διαθέτει το σύστημα SAP ERP είναι¨ 

• Ο κανόνας αρχής – τέλους (start - finish rule) 
• H τεχνική των ημερομηνιών ορόσημων (milestones technique) 
• βαθμός ολοκλήρωσης της διεργασίας (degree of progressing) 
• H απλή εκτίμηση (estimation) 
• H αναλογία χρόνου (time proportionality) 

 Από αυτές πρακτικά χρησιμοποιούνται στην Ελλάδα μόνο η τεχνική των 
ημερομηνιών ορόσημων και η απλή εκτίμηση της προόδου. 
 Ο κύκλος ζωής ενός έργου ολοκληρώνεται με την τακτοποίηση (settlement). 
 Κατά την τακτοποίηση ενός έργου τα κόστη και τα έσοδα καταχωρηθεί στο έργο 
ταχτοποιούνται σε αντικείμενα κόστους, τα οποία συνήθως είναι: 

• Κέντρα κόστους 
• Πάγια υπό κατασκευή (assets under construction) 
• Ή άλλα έργα 
 

 Οι πρότυπες εκτυπώσεις (standard reports) που σχετίζονται με την εφαρμογή 
διαχείρισης έργων project system βρίσκονται στο πληροφοριακό σύστημα των δομών 
των έργων (project information system), που περιλαμβάνει εκτυπώσεις που αφορoύν 
κόστη, έσοδα και άλλες πληροφορίες συνδυασμένες με τη δομή των έργων και  menu 
ρόλων χρηστών (role based use menus) που σχετίζονται με αυτή. 
 Βασικές εκτυπώσεις της εφαρμογής της διαχείρισης έργων είναι οι παρακάτω: 

• Επισκόπηση δομής έργων (project structure overview) 
• Προϋπολογισμός έργων (project budget) 
• Έργο προϋπολογιστικές γραμμές (project plan line items) 
• Έσοδα – Έξοδα έργου (project revenue expenses) 
• Εξέλιξη- πρόοδος έργων (project progress) 
• Απαιτήσεις υλικών έργου (project material requirements) 

 Σημαντικές οργανωτικές δομές του υποσυστήματος Διαχείρισης Έργων είναι: 
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• Οι αποθήκες της παραγωγής (εγκαταστάσεις και αποθηκευτικοί χώροι) και 
• Τα κέντρα εργασίας 
 

 Οι αποθήκες της παραγωγής είναι τυπικές αποθήκες της ομάδας εφαρμογών της 
Εφοδιαστικής, όπως ακριβώς ορίζονται στο υποσύστημα Διαχείρισης Υλικών. 
Οργανωτικά μία αποθήκη του PS ανήκει σε μία εγκατάσταση (plant) και μπορεί να 
περιλαμβάνει έναν ή περισσότερους αποθηκευτικούς χώρους (storage locations). H 
εγκατάσταση είναι ο χώρος στον οποίο παράγονται, αποθηκεύονται και διακινούνται τα 
υλικά που σχετίζονται με την παραγωγική και εφοδιαστική διαδικασία. 
 
 Τα κέντρα εργασίας (Work Centers) είναι παραγωγικά τμήματα, γραμμές ή 
μηχανές παραγωγής που ανήκουν σε μία εγκατάσταση και μπορούν να παρέχουν 
παραγωγικές δραστηριότητες ή δραστηριότητες συντήρησης. 
 
 Τυπικά κέντρα εργασίας μιας εγκατάστασης μπορεί να είναι τα παρακάτω 
αντικείμενα: 
Ø Μηχανές  
Ø Ομάδες μηχανών  
Ø Γραμμές παραγωγής 
Ø Ομάδες εργαζομένων στην παραγωγή κ.λπ. 
 

 Το κέντρο εργασίας είναι ένα από τα βασικά αρχεία, που εισάγουν δεδομένα σε 
ένα έργο, σε μία εντολή παραγωγής, τόσο για τον υπολογισμό των απαιτήσεων 
δυναμικότητας όσο και για τον προγραμματισμό των χρόνων και του κόστους 
παραγωγής. 
 
 Τα δεδομένα που συντηρούνται στα αρχεία των κέντρων εργασίας του 
συστήματος SAP ERP συμμετέχουν στους υπολογισμούς που αφορούν: 
§ Τον χρονικό προγραμματισμό, καθώς στα δεδομένα που συντηρούνται στα 
κέντρα εργασίας περιλαμβάνονται οι χρόνοι λειτουργίας και οι μαθηματικές 
σχέσεις (formula) που απεικονίζουν την παραγωγικότητά τους και έτσι είναι 
δυνατός ο υπολογισμός της διάρκειας των παραγωγικών δραστηριοτήτων που 
εκτελούνται σε αυτά 

§ Την κοστολόγηση, καθώς στα δεδομένα που συντηρούνται στα κέντρα εργασίας 
περιλαμβάνονται μαθηματικοί τύποι για των υπολογισμό των αναλώσεων των 
δραστηριοτήτων και την εξαγωγή αποτελεσμάτων στο υποσύστημα της 
Ελεγκτικής – CO μέσω της αντιστοιχίας κάθε κέντρου εργασίας με ένα 
συγκεκριμένο κέντρο     κόστους (cost center). 

§ Τον προγραμματισμό δυναμικότητας, καθώς στα δεδομένα που συντηρούνται 
στα κέντρα εργασίας περιλαμβάνονται η διαθέσιμη δυναμικότητα και οι τύποι 
υπολογισμού των απαιτήσεων δυναμικότητας. 
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Κάθε κέντρο εργασίας δημιουργείται σε επίπεδο εγκατάστασης (plant)  του 

συστήματος SAP R/3 και χαρακτηρίζεται από: 
• Κωδικό 
• Περιγραφή 
• Κατηγορία (π.χ. μηχανή, ομάδα μηχανών, γραμμή παραγωγής κ.λπ.) 
 

 Η συντήρηση των δεδομένων των κέντρων εργασίας γίνεται μέσω οθονών, που 
ομαδοποιούν τα δεδομένα ανάλογα με το σκοπό για τον οποίο εισάγονται. Αυτά 
περιλαμβάνουν τις παρακάτω όψεις: 

• Βασικά δεδομένα 
• Προτεινόμενες τιμές 
• Δυναμικότητες 
• Καθορισμός χρόνων 
• Κέντρα κόστους 
• Διαχείριση προσωπικού 
• Ιεραρχία κέντρων εργασίας 
• Τεχνικά δεδομένα. 
 

 Τα κέντρα εργασίας χρησιμοποιούνται στα φασεολόγια της παραγωγής και στις 
εργασίες συντήρησης εγκαταστάσεων και εξοπλισμού και ανάλογα με τις εργασίες που 
προσφέρουν είναι οργανωμένα σε ιεραρχίες κέντρων εργασίας (Work Center 
Hierarchy) για λόγους αναφορών (reporting) και εκτιμήσεων κόστους (evaluation). 
 
 Η ιεραρχία των κέντρων εργασίας συνήθως χρησιμοποιείται για να περιγράψει τις 
σχέσεις μεταξύ κέντρων εργασίας που αφορούν: 
Ø Τη συγκέντρωση κέντρων εργασίας με κοινή διαχείριση δυναμικότητας 
Ø Τη γεωγραφική τοποθέτηση 
Ø Τις οργανωτικές περιοχές ευθύνης 
 

 Πολύ συχνά η ιεραρχία των κέντρων εργασίας ακολουθεί κανόνες ονοματολογίας 
(naming conventions), οι οποίοι συνήθως οργανώνονται ως εξής: Οι πρώτοι τέσσερις 
χαρακτήρες υποδεικνύουν το ανώτερο κέντρο εργασίας και οι επόμενοι το επίπεδο 
ικανοτήτων (skill level). 
 
 Τα κέντρα εργασίας είναι βασική οργανωτική δομή των εφαρμογής του Project 
System  και είναι συνδεδεμένα με κέντρα κόστους συντήρησης εξοπλισμού (με σχέση 
που επιτρέπει πολλά κέντρα εργασίας να είναι συνδεμένα με ένα κέντρο κόστους, το 
οποίο χρησιμοποιείται για την κοστολογική διαχείρισή τους). 
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   H εφαρμογή της διαχείρισης έργων project systems χρησιμοποιείται από πολλές 
εταιρίες στην Ελλάδα κυρίως οικονομική-κοστολογικά παρακολούθηση και τον 
προϋπολογισμό των έργων που εκτελούν. Η εφαρμογή αυτή είναι από τις πιο δυνατές 
τόσο για την ανάλυση των έργων όσο και για τις διαδικασίες προϋπολογισμού και 
αναφορών (reporting) που συμφωνούν πλήρως με τα στοιχεία της οικονομικής 
διεύθυνσης και τα καθιστούν απόλυτα τεκμηριωμένα. 
 

 
 
Εικόνα 2.3 
Οι εκτυπώσεις της διαχείρισης έργων. 
 
 
 
 
 
 
 
 
 



ΔΙΠΛΩΜΑΤΙΚΗ ΕΡΓΑΣΙΑ - ΜΟΝΤΕΛΟΠΟΙΗΣΗ ΕΡΓΟΥ ΜΕΣΩ SAP PROJECT SYSTEM  

ΜΕΤΑΠΤΥΧΙΑΚΟ ΠΡΟΓΡΑΜΜΑ ΣΠΟΥΔΩΝ ΣΤΗΝ ΟΙΚΟΝΟΜΙΚΗ ΚΑΙ ΕΠΙΧΕΙΡΗΣΙΑΚΗ 
ΣΤΡΑΤΗΓΙΚΗ 

28  
 
Economic & Business Strategy 

2.4 Εισαγωγικά στοιχεία για το MS Project  
 
 
 To Microsoft Project (ή MSP) είναι ένα πρόγραμμα διαχείρισης του λογισμικού 
που αναπτύσσεται από τη Microsoft και έχει ως σκοπό να βοηθήσει τους διαχειριστές 
ενός έργου στην ανάπτυξη των σχεδίων, των πόρων, την ανάθεση καθηκόντων, την 
παρακολούθηση της προόδου, τη διαχείριση των προϋπολογισμών και την ανάλυση του 
φόρτου εργασίας.  
 
    Μέσω της εφαρμογής αυτής γίνεται ανάλυση της κρίσιμης διαδρομής και  
χρονοδιαγραμμάτων, αν και για την περίπτωση της κρίσιμης αλυσίδας μεθοδολογίες 
ανεξάρτητων add-ons προγραμμάτων είναι επίσης διαθέσιμες. Διαγράμματα διαχείρισης 
πόρων μπορεί δίνονται σε επίπεδα, ενώ οι αλυσίδες δραστηριοτήτων μπορούν να 
αναλυθούν διαγράμματα Gantt. Επιπλέον, το Πρόγραμμα μπορεί να αναγνωρίσει 
διαφορετικές κατηγορίες χρηστών. Αυτές οι διαφορετικές κατηγορίες χρηστών μπορούν 
να έχουν διαφορετικά επίπεδα πρόσβασης σε έργα, οθόνες, καθώς και άλλα δεδομένα. 
Προσαρμοσμένα αντικείμενα όπως ημερολόγια, οθόνες, πίνακες, φίλτρα και πεδία είναι 
αποθηκευμένα σε μια κοινή σε όλους τους χρήστες επιχειρησιακή δομή.  
 
   Αν και μέλος της οικογένειας του Microsoft Office, ποτέ δεν περιλαμβάνεται σε 
οποιαδήποτε από τις σουίτες του Office (πριν από το Office 2010 beta 1).Ο Microsoft 
Project Server και το Microsoft Project είναι οι ακρογωνιαίοι λίθοι του Microsoft Office 
Enterprise Project Management (ΕΡΜ) προϊόντος. Πιο συγκεκριμένα ο Project Server 
αποθηκεύει δεδομένα σε μια κεντρική βάση δεδομένων SQL, που επιτρέπει στους 
χρήστες την εμφάνιση και την ενημέρωση των δεδομένων αυτών μέσω του Internet. 
 
Χαρακτηριστικά 
 
  Το ΜS Project δημιουργεί ανάλυση προϋπολογισμού με βάση την εργασία και το 
κόστος των πόρων. Εφόσον οι πόροι έχουν ανατεθεί σε εργασίες και υπάρχει και 
εκτίμηση για τη διάρκεια της κάθε εργασίας, το πρόγραμμα υπολογίζει το κόστος ως 
εξής: ισούται με το έργο επί  την αμοιβή της εργασίας  που είναι συνδεδεμένο με κάθε 
εργασία (cost =  work x  rate) και στη συνέχεια σε κάθε ομαδοποίηση εργασιών και, 
τέλος, στο επίπεδο του έργου.   
 
 Με την έννοια πόροι εννοούμε ανάθεση ανθρώπων, εξοπλισμού και υλικών σε 
ένα έργο. Επίσης οι πόροι μπορούν να ανταλλάσσονται μεταξύ των έργων με τη χρήση 
μίας κοινής πηγής πόρων. Κάθε πόρος μπορεί να έχει το δικό του ημερολόγιο, το οποίο 
ορίζει για ποιες ημέρες και βάρδιες ο πόρος είναι διαθέσιμος. Το μοναδιαίο κόστος κάθε 
πόρου χρησιμοποιούνται για τον υπολογισμό του συνολικών δαπανών και πόρων που 
είναι συνδεδεμένα σε επίπεδο πόρου και αθροίζονται σε επίπεδο έργου. Κάθε πόρος 
μπορεί να ανατεθεί σε πολλαπλές εργασίες σε διάφορα project plan και κάθε εργασία 
μπορεί να ανατεθεί σε πολλαπλούς πόρους. Η εφαρμογή προγραμματίζει τις εργασίες με 
βάση την διαθεσιμότητα των πόρων, όπως ορίζεται στο σχετικό ημερολόγιο. Όλοι οι 
πόροι μπορούν να οριστούν σε μια επιχείρηση σε επίπεδο σε μία κοινή επιχειρησιακή 
δομή. 
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  Το MS Project προϋποθέτει ότι επιπρόσθετες πρώτες ύλες είναι πάντα διαθέσιμες, 
χωρίς όριο. Ως εκ τούτου δεν μπορεί να προσδιορίσει τον αριθμό των τελικών προϊόντων 
που μπορούν να παραχθούν με ένα συγκεκριμένο ποσό ανάλωσης των πρώτων υλών. Το 
γεγονός αυτό καθιστά το MS Project ακατάλληλο για την επίλυση των προβλημάτων των 
διαθέσιμων υλικών σε παραγωγική διαδικασία. Συνεργαζόμενα πακέτα λογισμικού 
απαιτούνται για τη διαχείριση μιας σύνθετη μονάδας που παράγει φυσικά αγαθά. 
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2.5 Εισαγωγικά στοιχεία για το Υποσύστημα Παρακολούθησης Έργων μέσω του MS 
Project  
 
 
  Ένα παράδειγμα διαχείρισης έργου στο MS Project ακολουθεί σε συνδυασμό με 
τις δυνατότητες για αναφορές και εργαλεία παρακολούθησης που διαθέτει η εφαρμογή. 
 
  Στο ξεκίνημα ενός έργου γίνεται ο προσδιορισμός των κάτωθι στοιχείων: 
Ø Εισαγωγή βασικών πληροφοριών Έργου: 
( Project → Project Information ) 
Ø Schedule From: Project Start Date 

• Γίνεται υπολογισμός της ημερομηνίας Λήξης του Έργου με βάση την 
ημερομηνία Έναρξης  και την ακολουθία των δραστηριοτήτων 

• Νέες Δραστηριότητες αποκτούν περιορισμό «Start As Soon As Possible»  
Ø Schedule From: Project Finish Date 

• Γίνεται προγραμματισμός των δραστηριοτήτων ώστε να τελειώσει το έργο 
επιθυμητή ημερομηνία και υπολογίζεται η ημερομηνίας Έναρξης 

• Νέες Δραστηριότητες αποκτούν  περιορισμό «Start As Late As Possible” 
Ø Καθώς και επιλογή ημερολογίου για το έργο  

 

 
 
Εικόνα 2.4 
Δημιουργία έργου στο MS Project. 
 

Το επόμενο βήμα στη δημιουργία ενός project είναι ο προσδιορισμός του 
ημερολογίου που θα χρησιμοποιηθεί με τις εργάσιμες ώρες και βάρδιες όπως φαίνεται 
και στο παρακάτω σχήμα. 
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Ø Διαμόρφωση ημερολογίου: 
( Tools → Change Working Time ) 

§ Καθορισμός εργάσιμων και μη εργάσιμων ημερών, ωραρίου εργασίας ή 
αλλιώς θα πρέπει να μεταβληθεί το Standard ημερολόγιο (αν χρειάζεται) 
από την αρχή του σχεδιασμού του έργου 

 

 
 
Εικόνα 2.5 
Ημερολόγιο του MS Project. 
 
  Στη συνέχεια διαμορφώνεται η λίστα δραστηριοτήτων δηλαδή γίνεται η ανάλυση 
του έργου σε δραστηριότητες.  
 

Οι Όψεις που διαθέτει (Microsoft Project Views) είναι οι ακόλουθες: 
§ Gantt  (που είναι και η εξορισμού όψη του προγράμματος) 
§ Παρακολούθηση Gantt (Tracking Gantt) 
§ Φύλλο Πόρων (Resource Sheet) 
§ Χρησιμοποίηση Πόρων (Resource Usage) 

      Η ανάλυση του έργου σε ομάδες δραστηριοτήτων γίνεται με εισαγωγή δεδομένων 
στο αριστερό μέρος του παραθύρου έργου στην όψη Gantt. 
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Συγκεντρωτική Δραστηριότητα 
 

 
 
 
Υποδραστηριότητα                                                       Γραμμή Τρέχουσας Ημερομηνίας 
 
Εικόνα 2.6 
MS Project Gantt chart. 
 

H προσθήκη συγκεντρωτικών δραστηριοτήτων και υποδραστηριοτήτων 
εξυπηρετεί τα ακόλουθα σημεία: 

• Στόχος είναι η οργάνωση των λεπτομερειών του έργου σε ομάδες 
δραστηριοτήτων που αντιστοιχούν στις σημαντικότερες φάσεις του έργου. 

• Μια συγκεντρωτική δραστηριότητα «συγκεντρώνει» τη διάρκεια, το 
κόστος και την εργασία των υποδραστηριοτήτων της. 

• Οι ημερομηνίες έναρξης και λήξης και η διάρκεια  των συγκεντρωτικών 
δραστηριοτήτων υπολογίζονται αυτόματα από το πρόγραμμα ως 
συνδυασμός των αντίστοιχων δεδομένων για τις υποδραστηριότητες. 

 
 Ένα σημαντικό σημείο όπως έχει ήδη προαναφερθεί είναι ο προσδιορισμός  των 
milestones ενός έργου. Τα ορόσημα – Milestones εν γένει και ειδικότερα στο MS Project: 

• Αντιπροσωπεύουν ένα σημαντικό σημείο του έργου, π.χ. ολοκλήρωση 
μιας φάσης του έργου, παράδοση παραδοτέων έργου. 

• Μια δραστηριότητα θεωρείται ορόσημο όταν έχει μηδενική διάρκεια. 
• H δυνατότητα χαρακτηρισμού δραστηριότητας ως ορόσημο και χωρίς 
μηδενική διάρκεια στην εφαρμογή δίνεται μέσω:  

(Project à Task Information à Advanced à Mark Task As Milestone) 
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 Επιπρόσθετα, σε ένα έργο μπορούν να οριστούν επαναλαμβανόμενες 
δραστηριότητες – Recurring Tasks. Χρησιμοποιούνται για αναφορές Προόδου, 
Τακτικές Συναντήσεις, κλπ.  
(Insert à Recurring Task) 
 

 
 
Εικόνα 2.7 
Recurring Task. 
 
 Για μία δραστηριότητα στο MS Project επίσης σημαντικό στοιχείο είναι το είδος 
της. Αυτό ορίζεται επιλέγοντας τη δραστηριότητα και (Project → Task Information).Το 
είδος της δραστηριότητας (Task Information →Advanced) χαρακτηρίζει τις δραστηριότητες 
με βάση τα στοιχεία τους (duration, work, unit) που διατηρούνται σταθερά και υπάρχουν 
οι εξής τύποι: 

• Σταθερής Διάρκειας (Fixed Duration) : W = D * U, όπου η αλλαγή 
στην εργασία ή τους πόρους δεν επηρεάζουν τη διάρκεια. 

• Σταθερών μονάδων πόρων (Fixed Units): όπου η μεταβολή της 
εργασίας σε μια δραστηριότητα επηρεάζει τη διάρκεια. 

• Σταθερής Εργασίας (Fixed Work): εδώ, η προσθήκη πόρων ελαττώνει 
τη διάρκεια.1 

 
 
 
 
 
 
 

                                                
1 Units: το ποσοστό του χρόνου του πόρου που είναι διαθέσιμο ή χρησιμοποιείται στη δραστηριότητα  
(π.χ. 3ανθρ. Full time - 300% ή 3) 
  Work:  Η εργασία που απαιτείται για τη δραστηριότητα (α/ω), από το σύνολο των πόρων 
  Effort-driven: η διάρκεια της δραστηριότητας ελαττώνεται ή αυξάνεται με την προσθήκη ή την 
αφαίρεση αντίστοιχα πόρων. Π.χ. W=32α/ω, D=2days, U=32/2 = 2 (200%), 2 ανθρ.- full-time 
 Αν U=100%, τότε για να παραμείνει το W σταθερό θα πρέπει να γίνει το D=4days (32h * 1ανθρ. = 32α/ω) 
Το fixed Work τσεκάρει και το Effort-driven. Με Fixed Units και Effort-driven πάλι επηρεάζεται η 
διάρκεια 
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Εικόνα 2.8 
Ορισμός πληροφοριών δραστηριότητας. 
 
 Άλλο στοιχείο απαραίτητο είναι ο ορισμός διάρκειας δραστηριοτήτων στο πεδίο 
Duration. 

• Μονάδες μέτρησης χρόνου είναι minutes, hours, days, weeks, months. 
• Καθορισμός προεπιλεγμένης διάρκειας μέτρησης χρόνου: 
( Tools →Options →Schedule ) 

 Ομοίως και η εισαγωγή περιορισμών (Constraints). 
• Προθεσμίες:  
(Project → Task Information →Advanced )  
• Περιορισμοί στην έναρξη και λήξη των δραστηριοτήτων:  
(Project → Task Information →Advanced →Constraint Type ) 
• Υπάρχουν 8 είδη περιορισμών στην έναρξη και τη λήξη δραστηριοτήτων: 

(As Late As Possible, As Soon As Possible, Finish No Earlier Than, Finish No Later Than, Must Finish On, 
Must Start On, Start No Earlier Than, Start No Later Than.) 
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Εικόνα 2.9 
Ορισμός τύπου διάρκειας δραστηριότητας. 

 
 Οι τρόποι σύνδεσης δραστηριοτήτων (με διπλό click πάνω στη γραμμή σύνδεσης 

μεταξύ 2 δραστηριοτήτων) είναι τέσσερις. 
• Λήξη με Έναρξη (FS) (Edit →Link Tasks)  
• Έναρξη με Έναρξη (SS) 
• Λήξη με Λήξη (FF) 
• Έναρξη με Λήξη (SF)  
 

 Η σύνδεση δραστηριοτήτων γίνεται με εισαγωγή προηγούμενων κάθε 
δραστηριότητας. Η εισαγωγή του αύξοντα αριθμού της προηγούμενης δραστηριότητας 
στο πεδίο Predecessors στο φύλλο εργασίας στην όψη Gantt είναι: 

 (Project → Task Information → Predecessors ) 
 Ένα ακόμη χαρακτηριστικό είναι ο χρόνος υστέρησης (Lag time) μιας εργασίας. 

Ορίζεται ως ο χρόνος που απαιτείται μετά την περάτωση μιας εργασίας για την 
ολοκλήρωσή της (π.χ. βάψιμο δωματίου). 

 
(Project →Task Information →Predecessors →Lag ) 
      Επιπλέον, ο χρόνος αλληλοκάλυψης (Lead time) είναι ο χρόνος που δηλώνει την 

αλληλοκάλυψη μιας εργασίας με την προηγούμενή της, δηλαδή καθορισμός χρόνου κατά 
τον οποίο μια εργασία μπορεί να αρχίσει ενώ η προηγούμενή της δεν έχει ολοκληρωθεί. 

 (Project →Task Information →Predecessors →Lag: αρνητικός αριθμός) 
 

 Μία ακόμη δυνατότητα που έχει το MS Project είναι ο διαχωρισμός δραστη-
ριοτήτων. Ένα παράδειγμα ανάγκης διαχωρισμού δραστηριοτήτων είναι ο προγραμ-
ματισμός εργασίας για μια συγκεκριμένη χρονική περίοδο και διακοπή αυτής για το 
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χρονικό διάστημα μιας εβδομάδας, για τις ανάγκες ενός επαγγελματικού ταξιδιού. Έτσι 
διακόπτονται όλες οι ενεργές δραστηριότητες κατά τη διάρκεια ενός έργου, ώστε να 
ενσωματωθούν οι αναπροσαρμογές στο χρονοδιάγραμμα. Μια δραστηριότητα μπορεί να 
έχει απεριόριστο αριθμό διακοπών. Για υλοποίηση διαχωρισμού δραστηριότητας: 
Από Gantt  Chart View, επιλογή (Edit èSplit Task ). 
 
Pert Analysis 
 
 Ένα σημαντικό πλεονέκτημα του MS Project είναι ότι διαθέτει ανάλυση Pert για 
εκτίμηση διάρκειας ενός έργου. 
 
            Ωστόσο πριν αναφερθεί η ανάλυση Pert στο MS Project είναι σκόπιμο να 
επισημανθούν τα ακόλουθα. Η τεχνική Pert βασίζεται στην  εκτίμηση  χρόνου 
περάτωσης εργασιών με βάση πιθανότητες: 
• Ελάχιστος (αισιόδοξος) χρόνος. 
• Συντηρητικός (πλέον πιθανός) χρόνος. 
• Μέγιστος (απαισιόδοξος) χρόνος. 
Ο αναμενόμενος χρόνος περάτωσης μιας εργασίας είναι: (a + 4 m + b)/6  
(βλ.παράρτημα) 
 Αναφορικά με το MS Project τώρα: 

• Γίνεται προβολή από το PERT Analysis Toolbar. 
(View à Toolbar à PERT Analysis )  
 

 
 
• Είναι δυνατή η χρήση του PERT Entry Sheet για εισαγωγή των τριών διαρκειών 

(αισιόδοξη, μέση και απαισιόδοξη) για όλες τις δραστηριότητες. 

  
• Μπορεί επίσης να γίνει χρήση του PERT Entry Form για εισαγωγή των τριών 
διαρκειών σε κάθε δραστηριότητα χωριστά. 

       
 Ακολουθεί ένα παράδειγμα του φύλλου εργασίας Pert (PERT Entry Sheet)  
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Εικόνα 2.10 
Φύλλο εργασίας Pert. 
 Το παρακάτω εικονίδιο αναπαριστά τη φόρμα εισαγωγής Pert για τις τρεις 
διάρκειες καθώς και εισαγωγή σταθμίσεων Pert. 
 

 
 
Εικόνα 2.11 
PERT Entry Form. 
 

 
 

Εικόνα 2.12 
Pert Weights. 
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 Εν συνεχεία θα πρέπει να αναφερθεί ότι υπολογίζεται η κρίσιμη διαδρομή με την 
τεχνική Pert καθώς και τα αντίστοιχα τρία διαγράμματα Gantt. 

• Υπολογίζεται η διάρκεια Pert:  
Calculate PERT 

       
• Δημιουργία τριών Gantt Charts: 
Optimistic Gantt Chart 

                   
Expected Gantt Chart 

                    
Pessimistic Gantt Chart 

                   
Επεξεργασία GANTT 
 
 Για την εύρεση του κρίσιμου μονοπατιού στην όψη Gantt  επιλέγουμε: 
(Format →Gantt Chart Wizard →Critical Path ): Εμφανίζεται με κόκκινο χρώμα το κρίσιμο 
μονοπάτι στο διάγραμμα Gantt ή 
 
 (Project →Filtered for →Critical ): Και στο διάγραμμα Gantt και στην αριστερή 
πλευρά του φύλλου εργασίας φαίνονται μόνο οι κρίσιμες δραστηριότητες  
 

 
 
Εικόνα 2.13 
Επεξεργασία Gantt. 
 
Προσθήκη πόρων 
 

 Ένα απαραίτητο στοιχείο σε ένα έργο είναι η κατανομή πόρων και η ανάθεσή 
τους σε δραστηριότητες. Η κατανομή των πόρων γίνεται είτε σε επίπεδο έργου είτε σε 
επίπεδο δραστηριότητας ανάλογα με το βαθμό λεπτομέρειας που απαιτείται. Η συνολική 
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καταγραφή όλων των διαθέσιμων πόρων γίνεται στο Φύλλο Πόρων (Resource Sheet) και 
αφορά τα παρακάτω στοιχεία: 

 
§ Εξοπλισμός 

 
§ Προμήθειες 
§ Ανθρώπινη Εργασία 
 

 Επιλέγεται η δραστηριότητα και με (Tools→Resources→Assign Resources) 
εμφανίζεται το παράθυρο ανάθεσης πόρων, απ’ όπου επιλέγονται ένας ή περισσότεροι 
πόροι και το ποσοστό χρησιμοποίησή τους. Στο φύλλο ανάθεσης πόρων εισάγονται 
λεπτομερή στοιχεία για τον κάθε πόρο όπως: 
Για τo Κόστος Πόρων 

§ Std Rate: Πληρωμή ανά μονάδα μέτρησης χρόνου 
§ Ovt Rate: Πληρωμή για υπερωριακή χρησιμοποίηση πόρου 
§ Per Use: Πληρωμή ανά χρήση του πόρου 
§ Τρόποι Πληρωμής: Κατά τη διάρκεια της εργασίας (Accrue At: Prorated), 
Με την έναρξη της εργασίας (Accrue At: Start), Με τη λήξη της εργασίας 
(Accrue At: End) 

 
 Στο φύλλο χρησιμοποίησης πόρων παρουσιάζεται αναλυτικά (ανά ημέρα) η 
χρήση του κάθε πόρου. 

 

 
 
Εικόνα 2.14 
Προσθήκη πόρων. 
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Kεφάλαιο 3 – ΜΟΝΤΕΛΟΠΟΙΗΣΗ ΠΡΟΤΥΠΟΥ ΕΡΓΟΥ ΜΕ ΤΟ SAP R/3  
  
 
3.1 Γενικά στοιχεία και περιγραφή της μελέτης περίπτωσης  
  
 
 Η μελέτη περίπτωσης που χρησιμοποιήθηκε σαν παράδειγμα με στόχο την επίδειξη 
του Project System εργαλείου του συστήματος SAP R/3, έχει σαν αντικείμενο το shut down 
του διυλιστηρίου του Ασπροπύργου των Ελληνικών Πετρελαίων. Αυτό το έργο εντάσσεται 
στο πλαίσιο εκσυγχρονισμού για το 2008 του Διυλιστηρίου Ασπροπύργου που 
διενεργείται κάθε 4 χρόνια. Κατά τη διάρκεια του shut down που αντιστοιχεί σε γενικό 
σταμάτημα των μονάδων παραγωγής πραγματοποιούνται εκτεταμένες εργασίες 
συντήρησης οι οποίες είναι απαραίτητες για την καλή λειτουργία του εξοπλισμού. Οι 
μονάδες του διυλιστηρίου τίθενται εν συνεχεία σταδιακά σε λειτουργία, με ελάχιστη 
καθυστέρηση. 
 
ΔΙΥΛΙΣΤΗΡΙΟ ΑΣΠΡΟΠΥΡΓΟΥ  
 

 
 
 Το διυλιστήριο Ασπροπύργου είναι σύνθετο (complex) κι ένα από τα πλέον 
σύγχρονα στην Ευρώπη. Διαθέτει μεγάλο αριθμό μονάδων διύλισης και μετατροπής 
βαρέων κλασμάτων σε λευκά προϊόντα. Οι μονάδες μετατροπής με υψηλό δείκτη 
πολυπλοκότητας αποτελούν το βασικό του πλεονέκτημα. Κύρια μονάδα μετατροπής 
είναι η μονάδα καταλυτικής πυρόλυσης με ονομαστική δυναμικότητα 45.000 βαρελιών 
την ημέρα. Η μονάδα κατεργάζεται ατμοσφαιρικό υπόλειμμα και απόσταγμα κενού των 
μονάδων κενού Ασπροπύργου και Θεσσαλονίκης για την παραγωγή λευκών προϊόντων.  
 
  Ενόψει των μελλοντικών περιβαλλοντικών απαιτήσεων, που έχουν τεθεί σε ισχύ 
από το έτος 2008 υλοποιεί νέα έργα ένα από τα οποία είναι και το shut down των 
μονάδων, προκειμένου να εξασφαλίσει τη δυναμική συμμετοχή του στην κάλυψη των 
αναγκών της αγοράς. 
           Για τη διαδικασία αυτή αναδιάρθρωσης του διυλιστηρίου παρατίθεται παρακάτω 
ένα πρόχειρο διάγραμμα που απεικονίζει τις βασικές μονάδες από τις οποίες απαρτίζεται 
και θα υποστούν συντηρήσεις. Σε αυτό παρουσιάζονται οι  μονάδες διύλισης και μετα-
τροπής  του διυλιστηρίου καθώς επίσης και οι μονάδες υδρογονοαποθείωσης U-3100 & 
U-3200 στις εγκαταστάσεις του Ασπροπύργου που κομμάτι αναβάθμισης των οποίων 
είναι αυτό που θα μας απασχολήσει στην παρούσα διπλωματική εργασία. Στις μονάδες 
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αυτές περιλαμβάνονται φούρνοι προθέρμανσης πετρελαίου, πύργοι απόσταξης, εναλλά-
κτες θερμότητας και δοχεία-δεξαμενές. 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Σχεδιάγραμμα 3.1 
Μονάδες Διυλιστηρίων 
 
 Πιο συγκεκριμένα, αντικείμενο μελέτης της εργασίας είναι η μεταφορά στο 
SAP R/3 ενός έργου, ενός πρότυπου εναλλάκτη αργού-νάφθας με τις δραστηριότητές 
του, που δόθηκε σαν έργο στο MS project. Η συντήρηση του πρότυπου εναλλάκτη είναι 
ένα από μία σειρά εκατοντάδων έργων επισκευής που πρέπει να εκτελεστούν για την 
ολοκλήρωση του εκσυγχρονισμού των διυλιστηρίων. Τα δεδομένα επομένως για τη δική 
μας μελέτη είναι ένα έργο με 33 δραστηριότητες (activities),6 ορόσημα (milestones), 
πόρους (resources), τόσο υλικά όσο και ανθρώπινους πόρους και το οποίο πρέπει να 
εκτελεστεί μέσα σε συγκεκριμένη χρονική διάρκεια. Αυτό το έργο θα πρέπει να έχει 
τελειώσει στις 15.05.2008. Οι δραστηριότητες που το δομούν ακολουθούν στη συνέχεια. 
 
 
 
 
 
 
 
 

ΕΛ.ΠΕ. 

Διυλιστήρια  
Ασπροπύργου 

Διυλιστήρια  
Ελευσίνας 

Διυλιστήρια  
Θεσσαλονίκης 

Μονάδες Διύλισης Μονάδες 
Μετατροπής 

U DD00 

 
… 

U 3200 

U 3100 

Πύργοι 
Απόσταξης 

Φούρνοι 
Προθέρμανσης 

Δοχεία Εναλλάκτες 
Θερμότητας 

Τ1 Τ2 Τ3 Τ4 
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3.2 Δεδομένα για την υλοποίηση του έργου (Project Realization) 
 
 
Τα δεδομένα που δόθηκαν στο MS project ήταν: 
 

Activity Activity Description Duration Start  Finish Predeccessor 

 

 
3-E-01A (ΕΝΑΛΛΑΚΤΗΣ ΑΡΓΟΥ-

ΝΑΦΘΑΣ) 
 

125 hrs 5/5/08 15/5/08  

1 Έναρξη εργασιών εναλλάκτη 0 hrs 5/5/08 5/5/08  
2  12 hrs 5/5/08 6/5/08 2 
3 Αφαίρεση μονώσεων 1 hr 6/5/08 6/5/08 2,3 
4  0 hrs 5/5/08 5/5/08  
5 Έλεγχος οργάνων  4 hrs 6/5/08 6/5/08 9 
6 Τοποθέτηση τυφλών 4 ehrs 6/5/08 6/5/08 2,3,4 
7 Αφαίρεση οργάνων 2 hrs 6/5/08 6/5/08 8 
8 Άνοιγμα εναλλάκτη 8 hrs 6/5/08 7/5/08 9 
9 Καθαρισμός δέσμης και λοιπών εξαρτημάτων 12 ehrs 7/5/08 8/5/08 13 

10 Εξάρμωση δέσμης 3 hrs 7/5/08 7/5/08 10 
11 Μεταφορά δέσμης για καθαρισμό 1 hr 7/5/08 7/5/08 12 

12 Επιθεώρηση δέσμης  και λοιπών 
εξαρτημάτων 3 hrs 8/5/08 8/5/08 11 

13 Μεταφορά δέσμης στον εναλλάκτη 1 hr 8/5/08 8/5/08 14 
14 Καθαρισμός Shell 4 ehrs 7/5/08 7/5/08 12 
15 Επιθεώρηση Shell 2 hrs 8/5/08 8/5/08 16 
16 Τοποθέτηση δέσμης 3 hrs 10/5/08 10/5/08 15,17,20 
17 Καταγεγραμμένες και πιθανές επισκευές 0 hrs 8/5/08 8/5/08 15,17 
18 Επιθεώρηση επισκευών 0 hrs 8/5/08 8/5/08 19 
19 Συσφίξεις 5 ehrs 10/5/08 11/5/08 36 

20 Έλεγχος εσωτερικών σπειρωμάτων στις 
μούφες των λαιμών (ταπών, thermowells) 4 hrs 7/5/08 7/5/08 10 

21 Υδραυλική δοκιμή Tube Side 6 ehrs 13/5/08 13/5/08 23,38 
22 Υδραυλική δοκιμή εκτονώσεων Shell side 24 ehrs 11/5/08 12/5/08 37 
23 Τοποθέτηση οργάνων 2 hrs 14/5/08 14/5/08 7,29 
24 Υδραυλική δοκιμή Shell Side 6 ehrs 14/5/08 14/5/08 27 
25 Κλείσιμο εναλλάκτη (Τοποθέτηση καμπάνας) 4 hrs 14/5/08 14/5/08 25,30,31 
26 Έλεγχος δομικών βάσεων εναλλάκτη 4 hrs 7/5/08 7/5/08 10 

27 Έλεγχος μεταλλικών στηριγμάτων εναλλάκτη 
(fixed & sliding saddles) 4 hrs 7/5/08 7/5/08 10 

28 Αφαίρεση τυφλών 4 ehrs 15/5/08 15/5/08 33 
29 Τοποθέτηση μονώσεων 2 hrs 15/5/08 15/5/08 28 
30 Αφαίρεση ικριωμάτων 0 hrs 15/5/08 15/5/08 32 
31 Λήξη εργασιών εναλλάκτη 0 hrs 15/5/08 15/5/08 32,33,34 
32 Άρμoση tube side 6 hrs 10/5/08 10/5/08 18 
33 Τοποθέτηση TEST RING 6 hrs 11/5/08 11/5/08 24,23 
34 Αφαίρεση TEST RING και άρμoση tube side 6 hrs 13/5/08 13/5/08 26 
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 Βάσει των δοθέντων στοιχείων στο SAP θα υλοποιηθεί ένα έργο το οποίο θα έχει 
ένα μόνο στοιχείο δομής εργασιών (WBS element), εφόσον κρίθηκε  αρκετό, στη βάση του 
οποίου θα αποδοθούν οι παραπάνω δραστηριότητες. Το WBS element όπως έχει ορισθεί 
και στο προηγούμενο κεφάλαιο ορίζει την ιεραρχία των εργασιών σε ένα έργο και διαιρεί το 
έργο σε χρήσιμα βήματα. Τα οργανωτικά δεδομένα που είναι συνδεδεμένα και απαιτούνται 
σε κάθε βήμα της δημιουργίας ενός project απεικονίζονται στο διάγραμμα που ακολουθεί. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Σχεδιάγραμμα 3.2 
Το σχεδιάγραμμα ενός έργου στο SAP και οι οργανωτικές του δομές  
 
 
 
 
 
 
 
 
 
 
 
 
 

Project Definition 

WBS element 

Networks 

Company code, Business area, 
Plant, Profit Center, Cost Center 

 

Company Code, Business area 
Plant, Profit Center, Controlling area 

 

Activities 
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3.3 Yλοποίηση του έργου στο SAP R/3 
 
 
 Σε αυτό το κεφάλαιο θα δημιουργήσουμε ένα καινούργιο έργο στο SAP και θα 
μελετήσουμε τους παράγοντες που το επηρεάζουν. Εν συνεχεία θα δημιουργήσουμε  τη 
δομή ανάλυσης εργασίας Work Breakdown Structure. 
 
Δημιουργία Έργου 
 
            Στην αρχική οθόνη δημιουργίας και επεξεργασίας έργου του SAP (Transaction 
Code CJ20N - Δομητής Έργου) δίνουμε τον ορισμό του project (3-E-01A), την περιγραφή 
του για τον εναλλάκτη αργού νάφθας και αποδίδουμε  σε αυτό ένα standard προφίλ 
(Standard Project Profile).  
 

 
Εικόνα 3.3 
Αρχική οθόνη επεξεργασίας έργου, δεδομένα ελέγχου 
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 Από αυτό το Standard προφίλ έρχονται προτεινόμενες τιμές στα παρακάτω πεδία 
όπως φαίνεται και στο σχήμα: 
 
Δεδομένα ελέγχου 
 
 To προφίλ έργου (project profile) ορίζει γενικά δεδομένα όπως την Περιοχή 
ελεγκτικής (Controlling Area), την εγκατάσταση (plant), το ημερολόγιο (Factory Calendar). 
Είναι υποχρεωτικό πεδίο όταν δημιουργείται ένα έργο. 
 Το προφίλ δικτύου (network profile) ορίζει γενικά δεδομένα όπως τη γραφική 
απεικόνιση, τις δραστηριότητες, το νόμισμα που θα έρχεται σα προτεινόμενο στις 
εξωτερικές δραστηριότητες 
 Στο προφίλ προγραμματισμού WBS (WBS scheduling profile), προσδιορίζονται 
στοιχεία όπως ο τύπος προγραμματισμού (forward ή backward). 
 

 
 
 Το προφίλ προϋπολογισμού (Budget Profile) ορίζει στοιχεία όπως το νόμισμα 
προϋπολογισμού (Budgeting Currency), τον επιτρεπτό ορίζοντα για προϋπολογισμούς στο 
παρελθόν ή στο μέλλον. 
 To προφίλ προγραμματισμού (planning profile) ορίζει στοιχεία όπως η costing 
variant και ο χρονικός ορίζοντας (time horizon). 
 
 Ο προγραμματισμός μεθόδου βασικών ημερομηνιών (planning method for basic 
dates) και ημερομηνιών πρόβλεψης (planning method for forecast dates)  έχει τις εξής 
επιλογές και αφορά μόνο τα WBS  και όχι τις δραστηριότητες: 

• Το Top Down Planning όπου οι ημερομηνίες προγραμματίζονται με βάση το 
ανώτερο επιπέδου WBS και ημερομηνίες αυτών των WBS που βρίσκονται κάτω 
από αυτό πρέπει να βρίσκονται στα όρια ημερομηνιών του ανώτερου επιπέδου 
WBS. 

• Το Bottom Up Planning όπου υπολογίζονται οι μέρες ξεκινώντας από το 
κατώτερο επίπεδο WBS. 
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• Το Strict Bottom Up Planning που είναι και μέθοδος που χρησιμοποιήσαμε 
όπου ορίζονται οι μέρες του κατώτερου επιπέδου για να οριστούν από το 
σύστημα αυστηρά στα χρονικά πλαίσια του ανώτερου. 

• Το Free Planning όπου υπολογίζονται οι ημερομηνίες χωρίς να παίζουν ρόλο οι 
ιεραρχικές εξαρτήσεις. 

 
Βασικά δεδομένα  
 
 Στα βασικά δεδομένα του έργου ορίζεται η ημερομηνία έναρξης και λήξης του 
έργου και έρχονται προτεινόμενους τιμές για το ημερολόγιο εργοστασίου, την περιοχή 
ελεγκτικής, την εγκατάσταση, το νόμισμα.  
 

 
 
Εικόνα 3.4 
Αρχική οθόνη επεξεργασίας έργου, βασικά δεδομένα  
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  Σε σχέση με το ημερολόγιο εργοστασίου έχουμε να παρατηρήσουμε ότι σα 
δεδομένο από το MS project όπως φαίνεται ακολούθως δόθηκε ένα calendar το οποίο ορίζει  
έξι μέρες εργασίας τη βδομάδα και δώδεκα ώρες ημερησίως. 
 

 
 
Εικόνα 3.5 
Παραμετροποίηση ημερολογίου για το έργο του εναλλάκτη στο MS project  
  
 Αντίστοιχα στο έργο του εναλλάκτη στο SAP αποδόσαμε το ημερολόγιο 
εργοστασίου W6 που αντιστοιχεί σε 6 εργάσιμες μέρες εβδομαδιαίως. Η αντίστοιχη 
παραμετροποίηση του ημερολογίου αυτού στο R/3 βρίσκεται στο ακόλουθο κομμάτι του 
customizing (Transaction Code SPRO – Customizing Implementation): 

 
 
Εικόνα 3.6 
Παραμετροποίηση ημερολογίου για το έργο του εναλλάκτη στο SAP, μενού πρόσβασης 
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Η παραμετροποίηση έχει τις εξής πληροφορίες: 
 

 
 
Εικόνα 3.7 
Παραμετροποίηση ημερολογίου για το έργο του εναλλάκτη στο SAP, λεπτομέρειες 
  
 Στο SAP στον ορισμό του ημερολογίου εργοστασίου αποδίδονται οι εργάσιμες 
μέρες, έξι στην εν λόγω περίπτωση. Κάθε εγκατάσταση έχει ένα ημερολόγιο, ενώ και στο 
project που δημιουργούμε πρέπει το ημερολόγιο που αποδίδουμε να είναι το ίδιο με αυτό 
της εγκατάστασης  του έργου. Οι πληροφορίες για τις ώρες εργασίας ορίζονται όχι στο 
ημερολόγιο όπως στο MS project αλλά στα κέντρα εργασίας. Για το project του εναλλάκτη 
έχουμε φτιάξει (Transaction Code CNR2- Αλλαγή κέντρου εργασίας) ένα κέντρο εργασίας (work 
center) στην εγκατάσταση 0001 με τις ώρες εργασίας όπως φαίνονται ακολούθως: 
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Εικόνα 3.8 
Κέντρο εργασίας, στοιχεία κεφαλίδας 
 
 Εδώ διακρίνεται για κάθε κέντρο εργασίες ο αριθμός των πόρων που δέχεται και το 
σύνολο της δυναμικότητας του κέντρου εργασίας στη βασική μονάδα μέτρησης. Επίσης 
μπορεί να ορισθεί η βάρδια (ή για μηχανές διάρκεια λειτουργίας) και τα διαλείμματα στα 
οποία δεν είναι διαθέσιμοι οι πόροι. 
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Δημιουργία WBS element 
 
 Δημιουργούμε στη συνέχεια (Transaction Code CJ20N - Δομητής Έργου) για το έργο 
που έχει ήδη οριστεί για τον εναλλάκτη ένα στοιχείο ανάλυσης εργασιών στο οποίο θα 
αποδώσουμε τις δραστηριότητες που έχουμε σαν δεδομένα. Δίνουμε ορισμό (1.1) και 
περιγραφή για αυτό (WBS ENΑΛΛΑΚΤΗΣ ΑΡΓΟΥ-ΝΑΦΘΑΣ), καθώς και ημερομηνίες 
έναρξης και λήξης. 
 

 
 
Εικόνα 3.9 
WBS, Εναλλάκτης αργού νάφθας 
 
  Χρησιμοποιώντας το ίδιο transaction της δημιουργίας έργου (CJ20N), 
συμπληρώνουμε επιπρόσθετα τις δραστηριότητες του δικτύου με βάση τα δεδομένα 
(δοθείσα διάρκεια, ημερομηνία έναρξης και λήξης) όπως αυτές απεικονίζονται στο 
παρακάτω σχήμα: 
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Εικόνα 3.10 
Δίκτυο δραστηριοτήτων εναλλάκτη. 
 
 Για να οριστούν οι σχέσεις μεταξύ των δραστηριοτήτων μαρκάρουμε όλες τις 
δραστηριότητες και επιλέγουμε την ένδειξη network structure graphic. Χρειαζόμαστε 
επιπλέον την πληροφορία για τις δομικές σχέσεις μεταξύ των δραστηριοτήτων. Γι’ αυτό το 
σκοπό επιλέγουμε το δείκτη που φαίνεται στο παρακάτω μενού  (connection button). Στη 
 

 
 
συνέχεια μετακινούμε τον κέρσορα στην πρώτη δραστηριότητα και την ενώνουμε με μία 
γραμμή που δημιουργείται με τη διάδοχο δραστηριότητα. Αυτή η γραμμή σύνδεσης 
αναπαριστά τη σχέση των δραστηριοτήτων ως εξής: 

• τέλος-αρχή 

 
• αρχή-αρχή 
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• τέλος-τέλος 

 
• και αρχή τέλος 

 
 
 Μετά τον προσδιορισμό των σχέσεων των δραστηριοτήτων για να μη δείχνει το 
δίκτυο χαοτικό, πατώντας το εικονίδιο της αναπροσαρμογής της εικόνας του γράφου (adjust 
button) οι δραστηριότητες επανατοποθετούνται. 
 
 Στο δοθέν ωστόσο έργο όλες οι δραστηριότητες είναι τύπου τέλους – αρχής και έτσι 
οι γράφοι τους στο SAP έχουν την ακόλουθη εικόνα: 
 

 
 
Εικόνα 3.11 
Γράφος δικτύου δραστηριοτήτων εναλλάκτη. 
 
 Στο δίκτυο διακρίνονται τα WBS Elements, η περιγραφή τους, το κλειδί τους στο 
SAP (π.χ. 10),η διάρκεια και οι ημερομηνίες έναρξης και λήξης. 
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 Η ίδια διαδικασία για τις σχέσεις των δραστηριοτήτων μπορεί να γίνει επιλέγοντας 
με διπλό κλικ την εν λόγω δραστηριότητα και προσθέτοντας σε αυτή τον κόμβο που προη-
γείται ή έπεται (predecessor-successors). Επίσης από εδώ μπορούν να οριστούν επιπλέον 
πληροφορίες για κάθε δραστηριότητα, όπως χρονικό περιθώριο μεταξύ predecessor και 
successor. 
 

 
 
Εικόνα 3.12 
Λεπτομέρειες δραστηριοτήτων εναλλάκτη. 
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Κοστολογική προσέγγιση SAP Project System (WBS structure) 
 
  
Γενικά στοιχεία 
 
 
 Η μέθοδος Cost planning ασχολείται με τα κόστη κατά τη διάρκεια ενός έργου. 
Στις διάφορες φάσεις ενός project εξυπηρετεί διαφορετικούς στόχους. 

• Στη φάση της σύλληψης και αρχικού σχεδιασμού ενός έργου η μέθοδος cost 
planning χρησιμοποιείται για να υπολογίσει τα έξοδα ενός έργου. 

• Στη φάση των εγκρίσεων χρησιμοποιείται σα βάση για την κατανομή του budget. 
• Στην πραγματοποίηση του έργου , χρησιμοποιείται για τον έλεγχο των 
αποκλίσεων των εξόδων. 

 
 Η διαδικασία cost planning εκκινά από το χαμηλότερο επίπεδο με την άθροιση 
των εξόδων. Στη συνέχεια.αιτείται budget από τους αρμόδιους. H διοίκηση εγκρίνει το 
αυτό το budget και τα κεφάλαια κατανέμονται σε διαφορετικά επίπεδα. Η κοστολόγηση 
(Controlling) είναι η διαδικασία ανάπτυξης στόχων και πλάνων , υπολογίζοντας την 
πραγματική επίδοση και συγκρίνοντάς τη με την πλαναρισμένη απόδοση ,λαμβάνοντας 
και διορθωτικά μέτρα εάν χρειαστεί.  
 
 Συχνά, στα πρώτα στάδια του σχεδιασμού ενός έργου μόνο πρόχειρες εκτιμήσεις 
του κόστους των εργασιών είναι διαθέσιμες. Σε αυτή την περίπτωση μπορούν τα κόστη 
να εισαχθούν χωρίς υπολογισμό από το σύστημα. Συνήθως χρησιμοποιείται υπολογισμός 
του κόστους μέσω των δικτύων (networks) βασιζόμενος σε τιμές και ποσότητες. H 
κοστολόγηση μέσω των δικτύων χρησιμοποιείται για αυτόματο υπολογισμό των 
πλαναρισμένων εξόδων μέσω των (activities που είναι διαθέσιμα στα κέντα εργασίας) 
και των υλικών που θα χρησιμοποιηθούν. Το παρακάτω γράφημα απεικονίζει πώς το 
σύστημα προσδιορίζει τα προγραμματισμένα έξοδα. 
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Εικόνα 3.13 
Quantity structure. 
 
WBS elements και κοστολόγηση 
 
 H χρησιμότητα των WBS elements από κοστολογικής πλευράς είναι ότι μπορούν 
να χρησιμοποιηθούν σαν φορείς κόστους (στατιστικοί ή πραγματικοί) προκειμένου να 
επιτύχουμε αναλυτικότερη παρακολούθηση των overheads όσο και εξόδων που 
πρόκειται να κεφαλαιοποιηθούν (capex). 
 
 Ειδικότερα υπάρχουν δύο τύποι WBS.Υπάρχουν WBS  που είναι στατιστικά 
(όπου το κόστος πέφτει πάνω στα κέντρα κόστους που είναι δεμένα στο βασικό αρχείο του 
WBS) και μπορούν να χρησιμοποιηθούν για budget availability control. Επιχειρησιακό 
παράδειγμα που χρησιμοποιούνται είναι έργα των πωλήσεων, του marketing, General 
Administration, κόστος αυτοκινήτων, κινητών κλπ. Επίσης υπάρχουν WBS  που είναι 
πραγματικά (πρόκειται για πραγματικούς φορείς κόστους που περιοδικά αδειάζουν μέσω 
του settlement) σε κάποιον άλλο κοστολογικό φορέα. Το settlement μπορεί να γίνει πάνω σε 
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κάποιο κέντρο κόστους (αν πρόκειται για Overheads) ή σε κάποιο πάγιο/πάγιο υπό 
εκτέλεση για τις περιπτώσεις που θέλουμε να κεφαλαιοποιήσουμε το συγκεκριμένο κόστος. 
 
 Κάποια πλεονεκτήματα χρήσης των WBS σε σχέση με άλλα κοστολογικά 
αντικείμενα διαχείρισης γενικών εξόδων (όπως π.χ. εσωτερικές εντολές) είναι τα ακόλουθα: 
 

1. Έχουν δεντρική μορφή (παρόμοια μ' αυτή της ιεραρχίας κέντρων κόστους) που 
επιτρέπουν τον επιθυμητό βαθμό ανάλυσης. 

2. Υπάρχουν όλα τα εργαλεία προγραμματισμού και budget καθώς και πολλά reports 
για σύγκριση πραγματικών-προϋπολογιστικών και διαθεσίμων ποσών. 

3. Επιτυγχάνει κανείς με τη χρησιμοποίηση τους ένα διαφορετικό επίπεδο ανάλυσης 
για στοιχεία προϋπολογισμού (πιο συνοπτικό - ορίζοντας το σε WBS ανώτερου 
επιπέδου-planning elements) και διαφορετικό για καταχώρηση απολογιστικών 
στοιχείων (account assignment objects). 

4. Είναι εφικτή η αλλαγή του status ανά κόμβο του έργου (WBS) και έτσι γίνεται να 
αποδεσμευτούν χρήματα με βάση την πρόοδο του έργο ή το χρονικό 
προγραμματισμό του. 

5. Υπάρχει δυνατότητα γραφικής απεικόνισης (σε δεντρική μορφή) των έργων. 
6. Τέλος είναι δυνατό να οριστεί υπεύθυνο άτομο(person responsible) ανά project και 
να καθοριστεί 

      ρόλος και security profiles για κάθε responsible person.  
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Kεφάλαιο 4 – ΣΥΓΚΡΙΣΗ ΤΟΥ ΠΑΚΕΤΟΥ MS PROJECT ΜΕ ΤΟ SAP R/3 
PROJECT SYSTEM 
  
 
4.1 Σύγκριση των δύο PMIS συστημάτων 
 
 Τα Πληροφοριακά Σύστημα Υποστήριξης της Διαχείρισης Έργων (PMIS) 
στηρίζουν με κατά το δυνατόν πιο αποτελεσματικό τρόπο το σύνολο των λειτουργιών 
διαχείρισης, παρακολούθησης και ελέγχου του κύκλου ζωής ενός έργου. Παράγοντες για να 
αποτιμήσουμε τα συστήματα PMIS μεταξύ άλλων θα μπορούσαν να είναι: 

 
• οι δυνατότητες χρονικού προγραμματισμού που διαθέτουν. 
• οι δυνατότητες Interfaces με άλλα συστήματα για πιο ολοκληρωμένη υποστήριξη 
επιχειρησιακών αναγκών. 

• ο μέγιστος αριθμός δραστηριοτήτων που επεξεργάζονται. 
• αποτελέσματα και αναφορές.. 
• οι εξαρτήσεις των δραστηριοτήτων. 
• διαχείριση κόστους. 
• προγραμματισμός πόρων . 
• ανάλυση κινδύνου. 
• ημερολόγια. 
• απαιτήσεις σε εξοπλισμό. 
• ευκολότερη διαχείριση μεγάλων έργων 
• δυνατότητα ταυτόχρονης διαχείρισης πολλών έργων και σύνδεσης μεταξύ των 
διαφόρων έργων. 

• αποτελεσματικός έλεγχος της εξέλιξης των έργων και έγκαιρη διόρθωση τυχόν 
αποκλίσεων από τη σχεδιασμένη πορεία. 

 
 Στην παρούσα εργασία εξετάστηκαν δύο πακέτα διαχείρισης έργων, το SAP R/3 και 
το MS Project και σκοπός είναι να γίνει προσπάθεια αποτίμησής τους με βάση τα 
αποτελέσματα που δόθηκαν από τη μοντελοποίηση ενός έργου και στα δύο συστήματα. 
Σημαντικός παράγοντας για τη σύγκριση των δύο συστημάτων είναι ο διαχωρισμός τους 
πρώτα σε τρία δομικά επίπεδα, ώστε να αναλυθεί και να συγκριθεί κάθε ένα από αυτά. 
 
Η Δομή των PMIS συστημάτων 
  
Αποτελείται από 3 κύρια υποσυστήματα: 
 
n Σχεδιασμού και Προγραμματισμού που αναλαμβάνει 

Ø Τον χρονικό προγραμματισμό ενός έργου. 
Ø Την κατανομή των πόρων. 
Ø Την κοστολόγηση του έργου και των επιμέρους δραστηριοτήτων. 

n Διαχείρισης που αφορά 
Ø Τη λογιστική και οικονομική διαχείριση. 
Ø Τη διαχείριση των συντελεστών της παραγωγής. 
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n Ελέγχου με κατάλληλες αναφορές που περιλαμβάνουν 
Ø Την παρακολούθηση της προόδου των εργασιών. 
Ø Και  τον έλεγχο του κόστους. 
 

Υποσύστημα Σχεδιασμού και Προγραμματισμού 
 
 Στο υποσύστημα  του σχεδιασμού και προγραμματισμού το MS Project διαθέτει 
δύο όψεις, Gantt Chart View και Pert2 Chart View. Αντίθετα το SAP R/3 διαθέτει μόνο 
ανάλυση διαγραμμάτων Gantt.  
 
 Στην παρούσα εργασία εξετάζεται μόνο η μέθοδος Metra Potential Method (MPM) 
που χρησιμοποιείται επίσης και στο SAP PS module και στο MS Project και αποτελεί την 
αφετηρία για την ανάλυση Gantt. H MPM μέθοδος χρησιμοποιεί ντετερμινιστικές δομές 
και διάρκειες. Σαν αποτέλεσμα ούτε πιθανότητες για π.χ. μία συγκεκριμένη διάρκεια 
ενός έργου μπορεί να υπολογιστεί ούτε να απεικονιστεί μία δομή με στοχαστικά 
στοιχεία. Αυτή θα ήταν για παράδειγμα η περίπτωση εάν επιθυμούσαμε να 
μοντελοποιήσουμε ένα έργο στο οποίο ένα τεστ θα μπορούσε να περαστεί και να είναι 
επιτυχές με κάποια πιθανότητα. Αυτό θα οδηγούσε σε λούπα που απαγορεύεται στην 
MPM μέθοδο. Το SAP PS σε αντίθεση με το MS Project επομένως δεν είναι κατάλληλο 
για επεξεργασία τέτοιου είδους έργων. 
 
  Ένα δίκτυο δεν απεικονίζει μόνο γραφικά τις σχέσεις μεταξύ των διάφορων 
δραστηριοτήτων, αλλά παρέχει και την πληροφορία για το κρίσιμο μονοπάτι. Το κρίσιμο  
μονοπάτι δείχνει ποιες δραστηριότητες είναι οι πιο κρίσιμες να πραγματοποιηθούν 
έγκαιρα και χωρίς να καθυστερεί όλο το έργο. Ο προγραμματισμός με τα δίκτυα 
βασίζεται στη θεωρία των γράφων. Η MPM μέθοδος χρησιμοποιεί κόμβους για την 
αναπαράσταση των δραστηριοτήτων και τόξα για την απεικόνιση των σχέσεών τους 
επειδή έτσι είναι πιο εύκολα αντιληπτά και είναι η μέθοδος ανάλυσης που είναι 
διαθέσιμη και στα δύο επιχειρησιακά πακέτα. 
 
 Σε σχέση λοιπόν αποκλειστικά και μόνο με τις τεχνικές χρονικού προγραμματισμού 
εάν επιχειρήσουμε να κάνουμε μία σύγκριση των δύο πακέτων καταλήγουμε στο ακόλουθο 
συμπέρασμα: 
 

                                                
2  Ξεκινώντας με τη ντετερμινιστική δομή και διάρκεια, δίκτυα με στοχαστική διάρκεια (όπως τα δίκτυα 
με ανάλυση Pert) ή και με στοχαστική δομή (όπως η Gert) προσφέρουν πολλές δυνατότητες στον χρονικό 
προγραμματισμό. Ωστόσο οι πιο πρακτικοί αντιμετωπίζουν με σκεπτικισμό τα αποτελέσματα αυτών των 
μεθόδων ιδίως σε επιχειρησιακά πλαίσια. Δημιουργούνται με αυτές τις μεθόδους μεγάλα και σύνθετα έργα για 
τα οποία απαιτούνται εργαλεία που είναι περίπλοκα στη διαχείριση.  
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 Επίσης και στις δύο εφαρμογές υποστηρίζονται και οι τέσσερις τρόποι σύνδεσης 
μεταξύ των δραστηριοτήτων (τέλος-αρχή, αρχή-αρχή, τέλος-τέλος και αρχή τέλος). 
Αμφότερα παρέχουν ικανοποιητικά αποτελέσματα σε χρονικό προγραμματισμό, ωστόσο το 
MS Project καθότι είναι πιο εξειδικευμένο διαθέτει όπως προαναφέρθηκε περισσότερες 
δυνατότητες σε αυτόν τον τομέα. 
 
 Στον τομέα τώρα της κατανομής πόρων και κοστολόγησης των επιμέρους 
δραστηριοτήτων εντοπίζονται και εκεί διαφορές ανάμεσα στα δύο εν λόγω συστήματα  
διαχείρισης έργων. Μία βασική διαφορά είναι ότι το SAP R/3 ως προς την κοστολόγηση 
είναι ότι διαθέτει τη λογική των κέντρων του κόστους και ότι τα WBS στοιχεία μπορούν 
επίσης και αυτά να αποτελέσουν φορείς κόστους και αυτά με ακόμη μεγαλύτερη ανάλυση 
από ότι τα κέντρα κόστους. Αυτά τα κόστη από τα έργα μπορούν εν συνεχεία να 
εξοδοποιηθούν ή να παγιοποιηθούν. Τέτοιες δυνατότητες ολοκλήρωσης (integration) που 
αφορούν συσχέτιση με τη λογιστική παρέχει μόνο το SAP και όχι το MS project. 
 
 Ειδικότερα, στο MS Project η διάρκεια θεωρείται συνήθως σταθερή, αλλά υπάρχει 
και δυνατότητα επίδρασης πόρων σ’ αυτή. Στο MS Project υπάρχουν οι ακόλουθοι τύποι 
δραστηριοτήτων: Σταθερής Διάρκειας (Fixed Duration), Σταθερών μονάδων πόρων 
(Fixed Units) όπου η μεταβολή της εργασίας σε μια δραστηριότητα επηρεάζει τη 
διάρκεια και Σταθερής Εργασίας (Fixed Work). Σε αυτόν τον τύπο δραστηριότητας η 
προσθήκη πόρων ελαττώνει τη διάρκεια. Αντιθέτως στο SAP PS δεν υπάρχει τέτοια 
δυνατότητα τέτοιας ταξινόμησης των δραστηριοτήτων. 
 
 Μία ακόμη διαφορά των δύο συστημάτων είναι σε σχέση με την προσθήκη 
πόρων ότι το SAP R/3 έχει τη δυνατότητα του διασύνδεσης του PS με τη διαχείριση 
αποθήκης. Μέσω του PS είναι εφικτή η δημιουργία για αιτήσεις αγοράς υλικών και 
παρακολούθησής τους που το MS Project δε διαθέτει. 
 
  Αναφορικά συγκεκριμένα λοιπόν, με την προσθήκη πόρων στα δύο συστήματα, 
στο MS Project υπάρχει ένα ειδικό το φύλλο εργασίας (resource sheet) το οποίο περιέχει 
πληροφορίες για τους πόρους σε ένα έργο. Σε αυτό το φύλλο εργασίας υπάρχει η 
δυνατότητα προσθήκης ανθρώπινων πόρων, υλικών και εξοπλισμού. Σε αυτά μπορεί να 
προστεθεί ένα πάγιο κόστος ανά χρήση (cost/use) ή ένα σταθερό κόστος ανά ώρα (standard 
rate),ακόμη και επιβάρυνση σε αυτό (overhead rate).  
 
 Στο SAP υπάρχει επίσης η δυνατότητα διαχείρισης πόρων (ανθρώπινοι πόροι, υλικά 
και εξοπλισμός). Δεν υπάρχει μία οθόνη για την ανάθεση πόρων αλλά σε κάθε 
δραστηριότητα ανάλογα με το είδος των πόρων μπορούν να προστεθούν ώρες εργασίας 
προσωπικού σε ένα κέντρο εργασίας(internal processing activities), ή ώρες εξωτερικής 
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εργασίας από τρίτους (external processing activities),ή και να προστεθούν υλικά (WBS 
component overview). Συγκεκριμένα όταν γίνεται προσθήκη υλικών σε ένα έργο 
ενεργοποιείται μία ανάγκη για εφοδιασμό υλικών στο SAP είτε μέσω παραγωγής 
(reservation), είτε μέσω αγοράς (purchase requisition). 
 
 Έτσι χρησιμοποιούμε για τον υπολογισμό του κόστους μόνο τα δίκτυα 
δραστηριοτήτων βασισμένο σε τιμές και ποσότητες και σε αυτά μπορούν να προστεθούν 
και overheads. Η κοστολόγηση δικτύου βασίζεται σε αυτόματο υπολογισμό (quantity 
structure) πλαναρισμένου κόστους από τις δραστηριότητες (activities) και τα υλικά 
(components). 
 
 Από τα παραπάνω συμπεραίνουμε ότι και στα δύο συστήματα υπάρχει ελλιπής 
παρακολούθηση πόρων και εκτίμηση κόστους με την έννοια ότι δε γίνεται ανάλυση trade-
off μεταξύ κόστους και χρόνου που είναι πολύ σημαντικός παράγοντας. Επιπλέον λόγω του 
ότι το SAP είναι πολύ περισσότερο γενικευμένο πακέτο, αν και δεν περιέχει τόσες πολλά 
στοιχεία και δυνατότητες για τον χρονικό προγραμματισμό ενός έργου ,όπως το MS Project, 
παρέχει ωστόσο πιο ολοκληρωμένο κύκλωμα επιχειρησιακών διαδικασιών. Για παράδειγμα  
όπως προαναφέραμε για τα υλικά και το κύκλωμα αποθήκης που ενεργοποιούνται σε ένα 
project είναι ένα κομμάτι που το MS Project δε διαθέτει. 
 
Υποσύστημα Διαχείρισης 

 
 Το υποσύστημα διαχείρισης αφορά τη λογιστική και οικονομική διαχείριση ενός 

έργου καθώς και τη διαχείριση των συντελεστών της παραγωγής. Στα συστήματα 
διαχείρισης έργων που εξετάστηκαν, ΜS Project και SAP υπάρχουν κάποιες διαφορές σε 
αυτό το λογιστικό και κοστολογικό τομέα. Αρχικά η κοστολόγηση για το SAP αφορά τρία 
στάδια. Στη φάση του σχεδιασμού, ο προϋπολογισμός του κόστους (cost planning) 
χρησιμοποιείται για να υπολογιστούν τα κόστη που θα πραγματοποιηθούν στη διάρκεια του 
έργου. Υπάρχει η φάση των εγκρίσεων, στην οποία ο προϋπολογισμούς του κόστους 
εξυπηρετεί σα βάση για την κατανομή του budget σε μία επιχείρηση. Εδώ ο υπεύθυνος για 
ένα έργο εγκρίνει τα ποσά θα διατεθούν με συνολική έγκριση του έργου ή το έργο 
εγκρίνεται ανά WBS element. Τέλος στη φάση της υλοποίησης του έργου ο σχεδιασμός του 
κόστους χρησιμοποιείται από την κοστολόγηση για να εντοπιστούν οι αποκλίσεις του 
κόστους. Στο MS Project δεν υπάρχουν στάδια εγκρίσεων, διαδικασία workflow ανά 
υπεύθυνο για κάθε κομμάτι του έργου, ωστόσο γίνεται προϋπολογισμός του έργου και 
ανάλυση για τις αποκλίσεις (planned versus actual). 

 
 Επιπλέον το SAP υποστηρίζει διαδικασίες κοστολόγησης έργων για προετοιμασία 
προσφορών μέσω του SAP SD module. Ένα τέτοιο παράδειγμα θα έβρισκε εφαρμογή σε 
μία κατασκευαστική εταιρία όπου ανάλογα με την παραγγελία του πελάτη γίνεται 
τιμολόγηση του έργου μέσω του PS. 
 
 Στο κομμάτι της διαχείρισης τώρα της διαχείρισης των συντελεστών της παραγωγής 
μία ακόμη διαφορά είναι ότι το MS Project προϋποθέτει ότι επιπρόσθετες πρώτες ύλες 
είναι πάντα διαθέσιμες, χωρίς όριο. Ως εκ τούτου δεν μπορεί να προσδιορίσει τον αριθμό 
των τελικών προϊόντων που μπορούν να παραχθούν με ένα συγκεκριμένο ποσό 
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ανάλωσης των πρώτων υλών .Το γεγονός αυτό καθιστά το MS Project ακατάλληλο για 
την επίλυση των προβλημάτων των διαθέσιμων υλικών σε παραγωγική διαδικασία. 
Επίσης όπως ήδη προαναφέρθηκε, εάν δεν αναφερόμαστε σε προϊόντα που χρειάζονται 
για ένα έργο και παράγονται στην ίδια την επιχείρηση, δεν έχει τη δυνατότητα να 
ενεργοποιήσει ένα κύκλωμα αγορών όπως το SAP. 
 
Υποσύστημα Ελέγχου με κατάλληλες αναφορές 
 
 Το υποσύστημα Ελέγχου συνιστά τη δυνατότητα σε αναφορές που να 
περιλαμβάνουν την παρακολούθηση της προόδου των εργασιών καθώς και ένα εξίσου 
σημαντικό μέρος της διαχείρισης έργων που είναι ο έλεγχος του κόστους. 
 
 Αμφότερα τα συστήματα διαθέτουν πακέτο αναφορών καθώς και είναι εφικτή η 
δημιουργία αναφορών για τις εξατομικευμένες ανάγκες της κάθε επιχείρησης. 
 
 Στο SAP το Project Information System είναι χρήσιμο για τον έλεγχο και την 
παρακολούθηση ενός έργου ενώ παράλληλα εκμεταλλεύεται και στοιχεία από άλλα module 
του SAP. Μπορούν να χρησιμοποιηθούν standard report ή να γραφούν καινούργια με τον 
Report Writer.Αυτά τα standard report προσφέρουν διαφορετικό βαθμό λεπτομέρειας, 
άθροισης, χρονολογίας των δεδομένων για: 

• Κόστη/ Έσοδα 
• Budget 
• Πληρωμές 
• Ημερομηνίες 
• Πόρους 
• Ανάλυση Earned Value 
 

 Εάν διαλέξουμε για παράδειγμα μία ιεραρχία  Plan/actual/απόκλιση για να 
συγκρίνουμε τα πραγματικά με τα πλαναρισμένα κόστη θα έχουμε μία εικόνα όπως 
παρακάτω:  
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Εικόνα 4.1 
Αναφορά Plan versus Actual στοSAP. 
 
 Αντίστοιχα και στο MS Project υπάρχουν αναφορές όπως το πλάνο αναφοράς 
(Baseline) και αποτελεί τη βάση των μετρήσεων της επιτυχίας του χρονοδιαγράμματος που 
έχουμε δημιουργήσει. Ένα τέτοιο παράδειγμα ακολουθεί: 
 

 
 

 
Εικόνα 4.2 
Πλάνο αναφοράς ΜS Project. 



ΔΙΠΛΩΜΑΤΙΚΗ ΕΡΓΑΣΙΑ - ΜΟΝΤΕΛΟΠΟΙΗΣΗ ΕΡΓΟΥ ΜΕΣΩ SAP PROJECT SYSTEM  

ΜΕΤΑΠΤΥΧΙΑΚΟ ΠΡΟΓΡΑΜΜΑ ΣΠΟΥΔΩΝ ΣΤΗΝ ΟΙΚΟΝΟΜΙΚΗ ΚΑΙ ΕΠΙΧΕΙΡΗΣΙΑΚΗ 
ΣΤΡΑΤΗΓΙΚΗ 

63  
 
Economic & Business Strategy 

 Επίσης οι ολοκληρωμένες εργασίες που η διάρκειά τους διέφερε από την 
προγραμματισμένη έχουν 100% ποσοστό ολοκλήρωσης, πραγματική ημερομηνία έναρξης ή 
λήξης και πραγματική διάρκεια. Αντίστοιχα ένα παράδειγμα παρακολούθησης των 
εργασιών σε πρόοδο με ποσοστό ολοκλήρωσης από 0 έως 99% και ημερομηνία έναρξης 
φαίνεται παρακάτω: 
 

 
 
Εικόνα 4.3 
Σύγκριση κατάστασης έργου με πλάνο αναφοράς ΜS Project 
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Παράρτημα A 
 
 
 Στο παράρτημα θα αναλυθούν και θα συγκριθούν δύο βασικές μέθοδοι ανάλυσης 
δικτύων δραστηριοτήτων η τεχνική Pert και η τεχνική CPM καθώς και κάποιες παραδοχές 
που γίνονται για τη χρησιμοποίησή τους. 
 
Οι Μέθοδοι PERT και CPM  
 

• PERT (Program Evaluation and Review Technique) 
Ανάπτυξη : U.S. Navy Special Projects Office (1958) 
Χρησιμοποιήθηκε για τη διαχείριση του έργου «Πύραυλοι Polaris» 

• CPM (Critical Path Method) 
Ανάπτυξη : J. E. Kelly [Remington-Rand] και M. R. Walker [du Pond] (1957) 
Χρησιμοποιήθηκε για το σχεδιασμό ημερομηνιών συντήρησης χημικών 
εργοστασίων 
 
CPM με σταθερό χρόνο εκτέλεσης εργασιών 
 
Θεωρούμε το εξής έργο μιας εταιρείας συμβούλων: 
 

 
 
Ακολουθεί η σχεδίαση του δικτύου δράσεων 

 
 
 Ο προσδιορισμός των «Κρίσιμων Χρόνων» Δράσεων γίνεται με την προϋπόθεση 
ότι θα υπολογιστούν οι παρακάτω χρόνοι: 
 

• Νωρίτερου Χρόνου Έναρξης (ES) 
• Νωρίτερου Χρόνου Περάτωσης (EF) 
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 Είναι δεδομένο ότι ο χρόνος έναρξης μιας δράσης εξαρτάται από το χρόνο 
περάτωσης των προηγούμενων συνδεόμενων δράσεων. Όπως φαίνεται στο ακόλουθο 
διάγραμμα έχουν υπολογιστεί για όλους τους κόμβους του γράφου οι χρόνοι ES και ΕF. 
 

 
 
 O υπολογισμός της κρίσιμης διαδρομής προϋποθέτει επίσης τον υπολογισμό των 
παρακάτω χρόνων: 
 

• Βραδύτερου Χρόνου Έναρξης (LS) 
• Βραδύτερου Χρόνου περάτωσης (LF) 
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 Γίνεται προσδιορισμός των «Κρίσιμων Χρόνων» Δράσεων και για τους χρόνους LS 
και LF για όλους τους κόμβους. 
 

 
  
             Το τελευταίο βήμα μετά τον προσδιορισμό των προηγούμενων χρόνων είναι να 
υπολογιστεί το Χρονικό Περιθώριο Δράσης καθώς και από αυτό και η Κρίσιμη Διαδρομή. 
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Τεχνική PERT 
 
Η τεχνική Pert βασίζεται στην  εκτίμηση  χρόνου περάτωσης εργασιών με βάση 
πιθανότητες: 
• Ελάχιστος (αισιόδοξος) χρόνος. 
• Συντηρητικός (πλέον πιθανός) χρόνος. 
• Μέγιστος (απαισιόδοξος) χρόνος. 
 
Ακολουθεί ένα παράδειγμα με ανάλυση Pert. Δίνονται οι παρακάτω χρόνοι. 
 

 
 
 
Τεχνική PERT - Αναμενόμενος χρόνος εκτέλεσης και πως υπολογίζεται. 
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Τεχνική PERT και υπολογισμός Κρίσιμης Διαδρομής 

 
 
 Το έργο απαρτίζεται από μια σειρά δράσεων με στοχαστική διάρκεια. Η συνολική 
διάρκεια του έργου, ισούται με τη διάρκεια εκτέλεσης της κρίσιμης διαδρομής και έχει 
μέση τιμή και τυπική απόκλιση εξαρτώμενη από τη μέση τιμή και τυπική απόκλιση του 
χρόνου εκτέλεσης των επιμέρους δράσεων. 
Βάσει του Κεντρικού Οριακού Θεωρήματος : 
 

 
Όπου, 
m = Μέση Τιμή Διάρκειας Έργου 
στ = Τυπική Απόκλιση Διάρκειας Έργου 
t = Αναμενόμενος Χρόνος Περάτωσης Μίας Δράσης 
σ = Τυπική Απόκλιση Διάρκειας Μίας Δράσης, που υπολογίζεται ως : 

 
Τ = Αναμενόμενη διάρκεια έργου = 54 ημέρες 
 
Παραδοχές για τις μεθόδους PERT / CPM 
 
• Οι δραστηριότητες (εργασίες) του έργου μπορούν να περιγραφούν ως 
ξεχωριστές οντότητες με σαφές χρονικό σημείο έναρξης και λήξης. 
• Η σειρά εκτέλεσης των εργασιών μπορεί να περιγραφεί υπό μορφή 
δικτύου δράσεων. 
• Ο έλεγχος του έργου βασίζεται στον έλεγχο της κρίσιμης διαδρομής. 
• Οι χρόνοι εκτέλεσης των εργασιών σε ένα διάγραμμα PERT 
ακολουθούν κατανομή β με τη διακύμανση του συνολικού χρόνου 
εκτέλεσης να ισούται με το άθροισμα των διακυμάνσεων κατά μήκος 
της κρίσιμης διαδρομής. 
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Παράρτημα B 
 
 
Παρακάτω παρατίθεται ο γράφος του εναλλάκτη αργού-νάφθας από το SAP R/3. 
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